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1. Intro

Concepts, workflow, terminology, etc.

1.1. CDI(LEN, LENX) or Not CDI(TIFF)

Workflow to an Esko CDI

Automation Engine offers a range of tools that help automate platemaking on a CDI. Using these tools
brings these benefits:

« Aview onthe CDI device within the Pilot, including its job load and queue management.
« Automatic merging of LEN(X) files onto a CDI plate.
« Detailed feedback from the CDIl about the exposed plates, including waste factors.

« Easy monitoring of status of a plates of a specific job, even when spread over several CDI plates or
merged with separations from other jobs.

« Easyremaking of CDI plates (full or partial).

Workflow to a non-Esko Flexo CTP device
A big part of this workflow is also possible when making the flexo plate on a non-Esko device, for
example a CTP device from Kodak.

This device can also be used in the same Plate Merger system. These merged plates also become
visible on the Merged Plates view.

The main workflow differences are:

. The merged plate is a TIFF file i.s.0. a LEN(X) file.

(f ’ Note: Remark that the RIP'ed data that you submit to the plate merger also in this case
need to be LEN files. The resulting merged plate will be TIFF.

Important: LENX files are LEN files that contain Crystal screens. The plate merger will
42808 error when he is asked to make a layout for a TIFF device, which does not have the required
‘Crystal technology.

« Thereis no feedback from the CTP device.

1 Attention: In this version, a workflow to a TIFF device still requires you to configure at least
one CDI device!

1.2. Terminology

While learning about the involved tools, it is important to understand the used terminology, especially
the terms Press Plate and Merged Plate.
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« CDI: Cyrel Digital Imager, Esko's digital flexo plate imager. Learn about CDIs on this web page.

- DFS: Digital Flexo Suite. A set of interactive applications to manually prepare LEN files and expose
them ona CDI.

« DFS Merger: The Merger is one of the applications of the DFS. An operator uses it to prepare LEN
files, merge them onto a layout, create a LEN file of that layout and send it to the queue of the DFS
Exposer.

One DFS Merger can drive several CDls, unless it is installed on the PC of the CDl itself (in which case
it is called 'Grapholas Merger').

« LEN(X)file: RIP output format that can be imaged on a CDI. Esko Imaging Engine can create LEN(X)
files. These files can also be the output of a DFS application like PlatePatcher.

- Merging: Placing LEN(X) files next to each other on a same layout, typically as many as possible, to
avoid wasting plate material.

PDF or PDFPLA LEN LEN or TIFF

MERGE 1

bﬁb RIP | Tﬂk‘ 5::?‘ |

/4
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“"PRESS PLATES” (AE)

“IMAGES” (DFS) “"MERGED PLATES” (AE)
“PLATES” (DFS)

+ "PressPlate": A RIP'ed separation (LEN(X) file) that can be merged before being imaged on a flexo
device.

The term "press" emphasizes that this a plate in the view of a printer: even when several are merged
with other Press Plates onto a CDI plate, they will be split/cut again after imaging and processing,
so that every Press Plate can end up as one plate on the press.

On the DFS, thisis called an "image". The terminology in the DFS applications is focussed purely on
the CDI(not on the whole workflow up to the printer).

On Automation Engine, a LEN(X) file becomes a Press Plate the moment it was submitted to the
Plate Merger.

A"Press Plate Set" is a group of press plates that belongs to the same job.

+  "Merged Plate™: A LEN(X) or TIFF file on which several Press Plates were merged. A Merged Plate
can contain several separations of a same job or even separations from other jobs. After imaging
and processing, a Merged Plate will be cut to end up with several plates for the press operator.

On the DFS, thisis called a "Plate", because this is one plate when being imaged on the CDI.


https://www.esko.com/en/products/overview/cdi/overview/
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When the chosen device is not a CDI, the merger creates a TIFF file.

« Kongsberg: Kongsberg cutting tables are typically used for their precision and productivity in
cutting for example plates with staggered cuts or PlatePatcher layouts.

1.3. Manual Workflow (DFS only)

This page first illustrates the manual workflow where DFS uses local LEN files to make the Merged
Plates fora CDI.

(DFS) Merger (DFS) Exposer

e / GG -_;_?.' e -l .
LEN files . —’] ~ gl |

Tex to CDI
.' E; % expose
HE queue
HE R, frmr— —_—
ﬂﬁ.r 6 Bt _\i _‘_:‘:_lg_ p

These are the main process steps:

1. LEN files are written into the "working folder" of the DFS station. These files can be created by an
Imaging Engine or FlexRip, or could have arrived from a remote site.

2. The DFS Merger operator

« selects the CDI and plate type that the layout will be exposed on. He then selects the LEN files
("images") from that "working folder" and loads them into the Merger.
« then manually creates a layout for the selected CDI plate and/or uses the "Auto Arrange” feature
to get some help with that.
« canuse interactive editing functions like crop, cut, rotate etc.
3. When afinal layout is made for that CDI, he presses "Expose!" to send it to the CDI's expose queue
(the Exposer application).
4. The CDl operator mounts a flexo plate on the CDIl and uses the Exposer application to start the
exposure.
5. After exposure, the plate goes through its post processing steps and may be cut before being sent
to the press room or shipped to the printer.
6. DFSalso writes HTML files containing the history of the exposed plates and their plate usage. These
can be used by an external system for job status or production statistics.

1.4. Automatic workflow (using AE)

In this workflow, Automation Engine replaces the use of a DFS Merger and provides extra tools to view
the history of this output.


https://www.kongsbergsystems.com/en/cutting-systems
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Plate Merger
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Merged Plate ¥iss g

LEN files arrive in Automation Engine. These were created by an Imaging Engine (or FlexRip). These
files can come directly from the RIP (in-house or remote) or can also come from the DFS application
PlatePatcher.

Note: When LEN files were already edited in PlatePatcher, the version of PlatePatcher
%= (Digital Flexo Suite) must be 20.0.16 or higher.

. Editing LEN files can be automated using the Add Margins and Crop tasks.
. LEN files are submitted to a specific queue of the Plate Merger, together with parameters defining

how and when they should be merged. A Merge Queue typically represents a plate type and can offer
several sizes of that plate type.

Note: You can also choose to add test strips or margins to the layout.

. When the Merge Queue decided on a layout, it starts a workflow that creates the Merged Plate LEN

file and then submits that file to the CDI's device queue.

Note: In this workflow, creating the Merged Plate LEN file is a task on your Automation
2= Engine server and not on the standalone DFS computer.

When the selected device is not a CDI, the workflow creates a TIFF file on a dedicated
output folder.

. The CDl operator uses the Exposer application to expose the Merged Plate.

Note: When so configured in the Plate Merger configuration, any successful imaging of a
&= (DI plate automatically triggers a workflow that submits the related cutting XML file to the
Kongsberg's iPC. Learn more here.

. In the Pilot's Views bar, the category 'Flexo' offers some extra views that support this workflow:

« The Merged Plates view shows all Merged Plates, in their different states. In this view you can
also easily resubmit plates back to the CTP queue, typically in cases where you need to remake
them. You can choose to resubmit the whole merged plate or only selected press plates.

» The Press Plates view helps you to overview which LEN separations are or have been part of this
workflow.
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« The Press Plate Sets view adds an extra job order perspective.

7. Reporting back to business systems. This workflow can also automatically sends reports to external
systems, both about what's happening on the device and about the status of the Job order. Learn
more in Reporting to Business Systems on page 11.

1.5. Semi-Automatic Workflow (manual intervention)

Automation Engine DFS Merger (AE mode)

o Plate Merger e
B Q for plate type A < @_ q
- Jis -

i Exposer
e 5 Submit -
e @— ~

— to CDI e
Create i* '

Merged Plate [

B Q for plate type B “

B Q for plate type C /

CLLLLY
292977

»B Q for plate type D =

Even when you use the tools in Automation Engine, you can still use the DFS Merger to manually
intervene. Some examples:

« When you want to use one of the partial flexo plates available in the plate room. Learn more in Plate
Merger on page 23.

- When you want to optimize plate usage by adding (smaller) Press Plates ("Images") that only recently
arrived in the queue and have a lower priority.

Note: This manual intervention to optimize the plate usage can sometimes be replaced

“=% by using the option to reconsider already merged plates: this puts all its press plates back
into the automatic merger and so makes them re-merge with any (small) new arrivals in that
gueue.

In the following cases, merging cannot be done by using the tools within Automation Engine. It has to
be done with the manual DFS Merger application, using local LEN files:

« InaDFS PlatePatcher workflow (corrugated).
« Tomanually crop LEN files.

Workflow steps:
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1. Whenusing the DFS Merger in AE Manual mode, the DFS user first selects one of the existing Plate
Merger queues on Automation Engine. To prevent any conflicts, the selected merge queue is
automatically paused.

2. The DFS user loads the Press Plates ("Images") that are present in the selected merge queue and
manually creates a layout with (some of) those.

3. When finished, the DFS user clicks "Expose". This automatically makes Automation Engine launch
the workflow that was defined for that merge queue. From this point on, the workflow is identical as
when working fully automatic: a merged plate LEN file is made from that layout and is then sent to
the CDI device queue.

Attention: Limitations in the DFS Merger when in AE manual mode:

» Itisnot possible to manually Crop the LEN files in the DFS Merger when it is set in AE
Manual mode. Consider using Automation Engine's Crop LEN File task.

« You cannot use the Viewer in DFS/PlatePrep to view the LEN files. Use the Automation
Engine Viewer instead.

- Whether a LEN file is allowed to be rotated or not is controlled by the merge queue setting
and/or by the value set for 'Rotation’in the '‘Submit to Plate Merger' task. If rotation is not
allowed, the rotation button in the DFS Merger application will be greyed out.

1.6. Introducing Flexo CTP Device related Views and Tasks

This page offers an overview of dedicated tasks and Pilot Views that enable the automation in flexo
CTP platemaking.

Find their detailed documentation in Flexo CTP related Views and Flexo CTP related Tasks.

Views and Tools

* ¥ Devices. This view shows an overview of your configured CDIs or flexo CTP TIFF devices (and
possibly other device types). It shows their general status and also the content of their expose
queue.

{ = Note: This view is also available from the Tools menu, which means you can also open it as
a separate window next to the Pilot.

* [ Plate Merger. This view is where you configure and monitor Merge Queues. A merge queue
calculates possible layouts of press plates (RIP'ed separations) onto a merged plate (CTP plate
layout).

* B Device Queues. This view shows the device queues in a graphical way. You see details about their
queue items and you can manage them (delete, change order, resubmit or, when possible, move to
another queue).

i =| Note: Thisview is also available from the Tools menu, which means you can also open it as
a separate window next to the Pilot.

* [ Press Plates. This view lists details about all press plates that were submitted to the plate merger.
It offers smart filtering, viewing and easy navigation to the job they belong to or to the merged plate
they are/were part of. You can also resubmit press plates back to the plate merger.
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F Press Plate Sets. This view shows the press platesin ajob order context. For example a CSR
(Customer Service Representative) can here monitor all jobs needing flexo press plates and see how
many have been imaged yet.

Merged Plates. This view shows details about all merged plates. When you select one and think
you can (now) get a more optimized layout than the one you see, you can choose to resubmit all its
press plates back to the plate merger. Double click a selection to zoom in and see a large preview
of its layout and details about their press plates. In this view, you can also resubmit a selection of
press plates back to the plate merger.

Tasks

® Add Margins to LEN file. Use this task to make sure there is enough room between press plates on
a merged plate. Alternatively, this can be also be done by adding Press Plate Margins in the merge
queue.

&/ Crop LEN file. Use this task to crop LEN files to the first image pixel or to the staggered cut line.
B Submit to Plate Merger. Use this task to submit LEN files (press plates)to the plate merger.

Ll Create Merged Plate. When the plate merger decides on a layout, it uses this task to create the
LEN or TIFF file of that layout.

| Submit to Flexo Device. This task submits the LEN of the merged plate to a CDI device queue. In
case of a TIFF flexo CTP, it submits the TIFF file of the merged plate to a folder that that device is
monitoring.

1.7. Main Steps in Setting Up this Workflow

10

Once you have a working setup of DFS (or Grapholas) software, then these are the main steps to set up
this workflow in the Pilot:

1.

Create one or more Devices. In the Devices View, click &¥ to add a device for every flexo device you
have.

Create Plate Merger queues. In the Plate Merger, click # ~ to add a merge queue for every type of
flexo plate that you use on any of the configured devices.

- Pick the type of plate from the list that is automatically retrieved from the configured CDI(s).

Attention: In this version, even when making a merge queue that you will use for a TIFF
device, you still need to pick a plate type from a list of plates that are configured on a
CDI. This list is read from a CDI's DFS within your network. In other words: to use a TIFF
device in this workflow, you also require to have at least one CDI configured.

« Then set all the other merger settings for every queue.

l” | Tip: When you have more than one CTP, it is not necessary to make a specific merge queue
for each CTP device. This would prevent the load balancing: the system can then no longer
decide to pick the least busy device.

Create an output workflow for the merge queue(s). In the Tickets view, create a workflow that
starts with creating the Merged Plate file (LEN or TIFF is automatically decided by the chosen
device) and that ends with submitting that file to a flexo device.
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Stant Creale Merged Submit to Flexo Ok
Plate CTP Device

Attention: When adding more steps to this workflow, make sure to still respect the
required input files for both these mandatory task steps. Learn more in these notes on
Output Workflows.

4, Attach the workflow to the merge queue(s). Complete the setup of the merge queue(s) by adding
the output workflow that you created in the previous step.

5. Test. Select agroup of LEN files, open a Submit to Plate Merger task, select the right plate type and
launch the task. When the fill rate is too small, use "Force Out"to see the next steps in the workflow.
You should see one or more new entries in the device queue.

6. Adapt your existing RIP workflows by adding a Submit to Plate Merger task at their end.

All the tools used in this workflow summary are described in detail in the pages on the Views and Tasks.

1.8. Reporting to Business Systems

When making digital plates, this type of information is often asked for:

« Statistics on plate usage: type, waste, etc.

« Statistics about the CDI: Till when is this CDI planned to be busy? How much time has it been
exposing this week and at what resolution?

« Joborderinformation: Are all press plates for this job exposed on the CDI yet? What is the plate
usage/waste for this job?

All this information can be sent to any external system by workflows that are automatically launched at
specific events in a CDl workflow. Learn more in Plate Merger Configuration on page 32.

This information can be delivered via XML files, web service calls, or even direct database interaction.
Learn more about such integration techniques in the chapter Integrating with External Systems.

1.9. Removed CDI Related Tools

In Automation Engine 14, the "CDI View" and the "Make Plate on CDI task" enabled a minimal connection
toa CDI.

These tools were removed in Automation Engine 16 when the current tools became available.

n



esko

Automation Engine

2. Flexo Device related Views

These tools and tasks and their concepts were introduced here.

2.1. Devices(CDI)

-\@} Tip: You can also open the view Devices as a Tool: Go to Tools > Devices to monitor and
“=  manage your devices in a separate window.

Adding a CDI Device

Follow these steps to add a CDI device:

1. Inthe Views bar, in the group 'Setup’, open the view Devices.

2. Click E2*. Select the category Flexo - CDI and click OK.
3. InServer, type in the name or the IP address of the computer of that CDI(the one where its
Grapholasis installed).

Attention: The computer that drives the CDI must be configured to use a fixed IP address.
This can be achieved by either setting a fixed IP address on that computer or by preserving
afixed IP address on the DHCP server.

4. Click Add to confirm. The blue status box of the newly created device appears.

Note: Older CDI devices show up in a lighter blue color.

Note: Adding a CDI device requires a license per device.

Information and functionality

Spark 2530 (new)

10...

The device status box shows following information that it gets directly from the Exposer application of
that CDI:

« The name of the device. By default this is the name of the computer where the DFS or Grapholas
software was detected. Open the @ Info panel to change it to a custom name.

« The amount of merged plates in the expose queue. This is the amount of jobs in its expose queue
(exposing and waiting).

12
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« Adevice statusicon.

: Retrieving the status.

: The device is offline. There is no connection with the device's computer (switched off,
network problem, etc.).

: The device is online. It could be idle or busy imaging.

The Estimated time when the current job load will be finished (how long the CDl is scheduled to
be busy).

1 Attention: CDIs with a Grapholas version 12 up to 14.0 can not feed a correct estimation
of the exposing time to Automation Engine. Therefore, in this view, you will not see this
information for these older devices.

Right-click a status box to choose one of these options:

* Info(or press @). This dialog shows details about the device (version, settings, etc.). You canadd a
Description to illustrate or help identify this device. Click Advanced Options for a detailed technical
list of its parameters.

* Delete (or press ©). You will be asked to confirm.
* New Device.... An alternative to clicking &4*.

2.1.1. CDI Device Status in an External Dashboard

Concept

Some customers are using a dashboard where they monitor their company's activity. This dashboard
can be a part of their business system or it can be custom-built. These sites often also want to see the
status of their CDI devices in that same interface.

i = Note: To get detailed information about specific plate consumption and job status, learn more
in Tab 'Reporting' on page 34.

The external system that shows the dashboard can ask Automation Engine for the CDI status viaHTTP
GET calls. It can so collect the same information that you can see in the CDI Device View:

« General device status(idle or exposing).

- The amount of merged plates in the expose queue. This is the amount of jobs in its expose queue
(exposing and waiting).

« The estimated time when the current job load will be finished (how long the CDl is scheduled to be
busy).

Regular updates of the status of all CDI queues can be retrieved via Server-Sent Events (SSE).

Syntax

« Getting the status of a specific CDI:
+ Inabrowser,goto<name-of-AE-server>:4412/FPL/cdi/<name-of-CDI-device> .

An example:

13
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B rdvmael9:4412/FPL/cdi

¢« C' | ® rdvmael9:4412/FPL/cdi/gend053 Q% & O 0 =

This XML file does not appear to have any style information associated with it.
The document tree is shown below.

v <(DI Generated="2017-89-26T11:92:19+02:80" device="gend®53">»
<IDLE>TRUE</IDLE>
<IP>19.31.133,184</1IP>
<QUEUELENGTH>8< /QUELELENGTH»
<TIME wnit="sec"”>4335</TIME>»
</CDI>

« Continuously getting the status of all CDIs via Server-Sent Events (SSE):

« Inabrowser, goto <name-of-AE-server>:44111/CDI. You will first see an info page. In
there, click the link to the Server-Sent Events to see the live status of all CDls.

« Per CDIl device, the following information is returned:

«  NAME: Name of the machine.

« IP: IP-address of the machine.

« STATE: OFFLINE: When the machine cannot be reached.
« IDLE: TRUE: When the machine is not exposing.

« IDLE: FALSE: When the machine is exposing.

« QUEUELENGTH: Number of entries in the expose queue.

« TIME: The time in seconds to empty the queue (on condition of continuously exposing from
now onwards).

An example:

14
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B Devices-CDI-55E

< (& |@rdmae19:44111,*'(’I']1frdi~;c,pj.hrml aw & O 0O E

Live CDI status updates

CDI State Quene-Length Finished
gend053 Idle 8 12:38:05
Spark 5080 (2) Idle 1 11:32:08
Spark 5080 (3) Idle 0

Spark 5080 (1) Idle 412:24:00

Event Log

Received:

{"NAME":"Spark 5080 (2)"."IDLE":"TRUE","TIME":378,"IP":"10.31.224.240" . "QUEUELENGTH":1}.
{"NAME""Spark 5080 (3)"."IDLE":"TRUE","TIME":0,"IP":"10.31.132.131","QUEUELENGTH":0},
{"NAME":"Spark 5080 (1)"."IDLE":"TRUE","TIME":3490."TP":"10.31.224. 206" ."QUEUELENGTH"4}]

"NAME";"Spark 5080 (2)"."IDLE":"TRUE"."TIME":378,"IP":"10,31.224.240","QUEUELENGTH":1},
{"NAME":"Spark 5080 (3)"."IDLE":"TRUE","TIME":0,"IP":"10.31.132.131"."QUEUELENGTH™":07},
{"NAME":"Spark 5080 (1)"."IDLE":"TRUE","TIME":3490,"TP":"10.31.224.206","QUEUELENGTH":4}]

{"NAME":"Spark 5080 (2)"."IDLE":"TRUE"."TIME":378,"IP":"10.31.224 240" ."QUEUELENGTH":1}.
{"NAME""Spark 5080 (3)"."IDLE":"TRUE"."TIME":0."TP":"10.31.132.131"."QUEUELENGTH":0}.

{‘\IAMZE Spal‘k 5080 (1) "IDLE": IRUE' "TIME":3490,"TP""10.31.224.206","QUEUELENGTH":4}]
I L3 *1 " OCTTRAE™-433S TR0 31 133 184" "N TETTET ENGTH" 21

11:25:50 [{"NAME":"gend053"."IDLE":"TRUE"."TIME":4335,"IP":"10.31.133.184","QUEUELENGTH":8}.

11:25:40 [{"NAME":"gend053"."IDLE":"TRUE"."TIME":4335,"TP":"10.31.133.184"."QUEUELENGTH":8}.

11:25:30 [ {("NAME":"gend053" "IDLE":"TRUE","TIME":4335."P":"10.31.133.184" "QUEUELENGTH":8},

Ask your browser to view the source of this web page. This will reveal the JavaScript that
translates the incoming events to the readable table.

An example (in the browser 'Chrome’):

15
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2.2.

667 x 375 100%¥ & | R (] | Hements

Saurces ¥
*Otop
¢ rdvmael9:44111
Live CDI status updates v i D!
B cdisselhtmi
CDI State Quene-Length Finished
gend053 Idle 0
Spark 5080 (2)Idle 115:13:29
Spark 5080 (3)Idle 0
Spark 3080 (1) Idle 115:26:00
Event Log

Devices (TIFF)

95
96
ai
98
93
laa
lel

121
122
123
124
125
126
127

Automation Engine

Consoletw\ork Performance  Memory  Application  Security
: | (4] | cdisselhtml %

L
cell = row.insertCell(l); cell.innerHTML = (cdi["IDLE"]

cell = row.insertCell(2); cell.innerHTHML = cdi[ "QUELELE
cell.align = "right™;
if (cdi[ "QUEUELENGTH"] » @)
1
cell = row.insertCell({3); cell.inmerHTML = fmtTime(ad
cell_align = “right";
}
¥
YA for i
Y 4/ functien updCDITable
J{b.
* install the EventSource if supported by browser
4
if(typeof(EventSource) l== “"undsfined™)
var source = new EventSource(”/CDI/SSE");

- Ronmes sage = function{event)

updEventlog (event.data);

else
document, getElementById("eventlog™ ). innerHTML
<fscripts

</body>»
< /html»

= "Sarry, you

. Note: We here only describe the differences with adding an Esko CDI device, as described

above.

Adding a Flexo TIFF Device

Follow these steps to add an offline Flexo CTP device that you will send TIFF files to.

1. Inthe Devices view, click on E&*.
2. Select the category Flexo - TIFF and click OK.
3. Fillin the device's properties:

16
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New TIFF CTP Device o

Ie Add & TIFF CTF Device.
Enter the properties of the TIFF CTP Device you want to add.

HName: | My Old Flexo Flatemaker

Image Width: {1250 mm
Image Height: | 650 mim
Compression: LZW v:
|| negative background

| Mirror

Output Folder: |sdvmae23/ExamplelobContainer/CTP_Output/For_TIFF_device

Monitor output folder as plate queue

Add [ Cancel

Name: Type a name for this TIFF device.

Image Width and Image Width: Define the (maximum)size of the output TIFF (merged plate) for
this device to expose.

Compression: Select the compression for this output TIFF file.
Negative background: Should this TIFF file have a negative background?
Mirror: Should the data be mirrored on that TIFF file?

Output Folder: Define where all output TIFF files (merged plates) for this device should be
written.

Monitor output folder as plate queue: Select this to enable the device's status box to show this
information:

« Number of plates. This is the number of TIFF files currently in the output folder.

« Aroughtime estimate. There is no link with the device to obtain any idea how long it will take
to expose these plates. Therefore, the system uses a default estimate of 30 minutes per plate
and 3 minutes in between plates.

Click Add to confirm. An olive green status box of the new device appears.

My Old Flexo Flatemakar

| plates

1 Important: To change the name of a device, right-click the device's status box and

42800 choose Rename.

17
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2.5. Press Plates

18

{ ' Note: The terms "Press Plates" and "Merged Plates" were introduced in the page on Terminology
]
on page 4.

Concept

This view lists all the Press Plates in rows. These are the LEN files that were submitted to the Plate
Merger. Select one to see a preview and some key information in a pane on the right.

When your Pilot is in a specific Job mode, you only see the press plates of that Job.

Depending on the type of information you are looking for, you may want to see the entries grouped
differently. An extra line then separates the groups. To set your preference, select any entry, right-click
and choose:

« Grouped by Press Plate Set. This groups all entries that were submitted together by the same
Submit to Plate Merger task. Because these entries are likely coming from the same graphics file,
the focus of this view is more on the delivery of these press plates: It helps answer questions like
'‘Can we move them to the press? or 'Can we ship them soon?'.

A similar view is offered in the Press Plate Sets view, but there you see a different kind of
information in the right pane.

« Grouped by Merged Plate. This groups all entries with the other press plates that are or were part of
the same merged plate. This focus of this view is more on the CTP device.

Columns

| ' Note: Asin many views in the Pilot, you can

- re-arrange columns by dragging their title to a new position
« sortthem by clicking on a column title

« right-click a column title and choose to Hide this one or any other. In the list that appears,
select Select Columns... if you want to change or re-arrange multiple items.

- use filters and optionally save them as a Smart View.

« define your preferred unit in Edit > Preferences > Units.

Several of these columns only get their value as the press plate progresses through its workflow.

+ File Name: Name of the LEN file.

« Folder: Full path where the LEN file resides.

« OrderID: The order ID of the Job that the LEN files of the press plates reside in.
+ Resolution: Resolution of the LEN file.

+ Size: V-H size of the LEN file.(This is the size the plate merger uses when calculating layouts).



esko

« Device: Name of CTP device that the layout containing this press plate was made for. This field is

Automation Engine

empty when the state is still "In Plate Merger".

« Inkname: Asread from the LEN file's XMP metadata.

- Rotation: Rotation as requested in the Submit to Plate Merger task: 0, 90 or mq (= "Set by Merge

Queue").

« State of each press plate:

g
’

] Tip: Hover your mouse over a status icon to read its meaning.

] Tip: When using the filter, click CTRL to filter on multiple statuses.

Press Plates ¥ Devices

L}

Search: |All| File Name Order ID Press Plate ID
sate~is HEH EDEDRBERMFE

& In Plate Merger: Still an entry in a merge queue of the plate merger.

f In Output Workflow: Part of a merged plate that is currently in its merge queue’s output
workflow.

Queued on CDI: Part of a merged plate thatisin a CDI device queue.
@ Exposing on CDI: Part of a merged plate that is being exposed on the CDI.
¥ Exposed: Part of a merged plate that was successfully exposed on the CDI.

M Exposed (Warning): Part of a merged plate that was exposed on the CDI with a warning.

E Error (In output workflow): Part of a merged plate that encountered an error in its merge
queue's output workflow.

& Error: Part of a merged plate that was exposed on the CDI with an error.

[ Cancelled: Part of a merged plate that was cancelled (removed) from the CDI's "Exposer”
queue.

Unknown: Status unknown.

- Imaging Technology: The technology that was requested for this LEN file when it was submitted to
the plate merger.

« Manufacturer, Thickness and Type: Plate specifications, as retrieved from DFS or Grapholas during
the workflow.

« Timing

Due date: Time specified in the Submit to Plate Merger task. When none was specified, a due

date is set at 3 days after the submitting to the merger.

Finished: Time when this press plate was finished exposing on the CDI.

19
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+ Launched: Time when this press plate was submitted to the plate merger.

Plate usage, retrieved from the layout XML created by the plate merger:

« Used Area: Area that this press plate uses on the merged plate.

- Waste: Area of this press plate that is not used area. (press plate margins, cut marks area)
+ % Used Area: % of used area of the merged plate that this press plate is part of.

+ % Waste: % of unused area of the merged plate that this press plate is part of.

E b ] Note: In previews of the merged plate, the waste area is shown in pink.

When this press plate also requested a cutting workflow, these fields will get their values when that
workflow is executed on the Kongsberg:

» Cutting Flow: Name of cutting workflow chosen in the Submit to Plate Merger task.
« Cut State: (Not) Ready for Cutting, Done, Error or Cancelled.

Custom fields (names defined in the Plate Merger item in the Configure tool).

Internal ID numbers

- Merged Plate Id: A unique identifier for the merged plate that this press plate was placed on.
In the reporting XMLs, it is mentioned as an attribute for Plate id.Forexample: <Plate
id="56c3-2e£f4-0001">.

+ PressPlate ld: A unique identifier for that press plate. In the reporting
XMLs, it is mentioned as the element <IdOnPlate>. For example:
<IdOnPlate>000070518 20151210152733 process_Yellow</IdOnPlate>.This|D
was first created by the RIP when it created the LEN file and then added it to it's XMP metadata
as<egPlate:plateid>.

Learn more in Interpreting the Reporting XML files on page 91.

E b ] Note: This Id had no relation to the 'Plate ID' as described in Working with Plate ID on page
82.

Functionality

Right-click an entry to choose any of these actions(some are only available in specific statuses):

Resubmit Press Plates: This resubmits all selected entries back to the plate merger(same LEN
files with same submit options). You will be asked to confirm.

This is useful when a part of a flexo plate was damaged or when your press operator requests a new
plate of only that specific separation.

Restriction: The LEN file of the selected press plate still needs to exist (on the same
folder).

[ ( ] Tip: The Merged Plates view also offers to resubmit (parts) of a merged plate.

Go to Job: When the Pilot is in Container mode, use this to have the Press Plates view go to the Job
mode of the Job that this press plate belongs to.
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« Go toFile: Opens the Files view and selects the LEN file of this press plate. This can be useful to
check its XMP metadata ('@).

+ Show in Plate Merger: Shows this item in the Plate Merger Queue (when present there).

« Go to Merged Plate: Opens the Merged Plates view, zooms in on the merged plate that this press
plate belongs to and selects that press plate in the preview (blue line).

« Show Related Tasks: This open the Tasks view and shows the workflow that was used to create the
merged plate and submit it to the flexo device.

« View. Opens the press plate's LEN file in the Automation Engine Viewer. This will require the LEN
file to have prepared view data(learn more in Working with RIP data in the AE Viewer).

E b ] Note: If you wish to open LEN files in the DFS "View" application (aka "Esko Bitmap Viewer",
Windows only), then choose 'Go to File' and double-click the file there. This will open the file
in the application that you first instructed your local computer to ‘open with'.

« Group by Press Plate Set: Use this to see the rows grouped by entries that were submitted
together.

« Group by Merged Plate: Use this to see the rows grouped by the merged plate they ended up on.

E b ] Note: You cannot select and delete entries in this view. They will be removed based on the
automatic clean up option in the Plate Merger item in the Configure tool.

Press Plate Sets

Concept

This view is intended for CSRs (Custom Service Representatives). It adds an overview of Job orders
and the status of their required press plates in their workflow to the flexo device. This can also include
the workflow of cutting the flexo plate on a Kongsberg table.

In Container mode, this view shows all press plate sets, created in a Job context or not. In Selected Job
mode, it only shows those created in that selected Job.

[ ( ] Tip: Especially in Container mode, it can be useful to work with Smart Views: one could focus
on plate status, another on plate waste, etc.

The Right Pane: Pie Chart and Details

Select an entry to see a graphical overview and some key information in the right pane.
« The pie chart shows in color how many press plates of the selected set are in which status:

- [ InPlate Merger: How many are still in the Plate Merger, waiting to be put on a merged plate.

« [ In Output Workflow: How many were recently merged on a plate and are still in the merge
queue's output workflow.

+ [ Queued On CDI: How many are part of a merged plate that is in a CDI "Exposer" queue.

- [ Exposing: How many that are part of a merged plate that is current being exposed on the
CDI.
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. Expose Done: How many that were exposed on the CDI but are still to be cut on the
Kongsberg table (also see column "Cut State"). For TIFF devices, this status is already set shortly
after the TIFF layout arrives in its output folder, i.e. where the workflow on Automation Engine is
done.

. Expose Error: How many that experienced an error during exposing on the CDI.

- [l Expose Cancelled: How many are part of a merged plate that was cancelled when being
exposed on the CDI.

« I CutError: How many where an error appeared during cutting on the Kongsberg table.

« [ Cut Done: How many where the whole workflow is done successfully. These were exposed on
the CTP and, if requested, also cut on the Kongsberg table.

» Atthe bottom of the right pane, click # to see the amount and the names of all the Press Plates and

(if available) Merged Plates for this set.

« "InPlate Merger' shows the amount and the names of the press plates that are still in that state.

—/M In Plate Merger: 2 >
Red Wine Front 2011_Varnish.len

Red Wine Front 2011_201.len

In case you wonder why they are still in the plate merger, click = or click on a specific press
plate name to open the plate merger view and select them in their merge queue, where you can
read details about their state.

Tip: Use the arrow buttons <! > = &5 in the Pilot tool bar to come back to this
previous view.

« "InError'lists the press plates of which some step in the workflow failed.

Columns

Note: Asin many views in the Pilot, you can

« re-arrange columns by dragging their title to a new position

» sort them by clicking on a column title

« right-click a column title and choose to Hide this one or any other. In the list that appears,
select Select Columns... if you want to change or re-arrange multiple items.

- use filters and optionally save them as a Smart View.

« define your preferred unit in Edit > Preferences > Units.

Columns describing a status (see above list) show the amount of press plates of this set are in that
status. The possible statuses are very similar to those described in the Press Plates view.

Functionality
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«  GotodJob: The view filters itself to the Last Used Job mode of the job that these press plates
belong to.

« GotoFolder: The view switches to the Files view and selects the folder where the press plates' LEN

files are. This is for example useful to check their XMP metadata (@)orto manage their prepared
view files.

« Show in Press Plates: Opens the Press Plates view and selects all press plates of this set. This is
useful to check more detail about the different press plates or to see the (internal) ID of the merged
plate(s) they ended up on.

« View: Opens all press plate's LEN files together in the Automation Engine Viewer. This will require
all LEN files to have prepared view data (learn more in Working with RIP data in the AE Viewer).

2.5. Plate Merger

Concept

LEN files are sent to the plate merger by submitting them to a specific Merge Queue. Each merge
queue has it own settings regarding plate type, size and merge parameters. For each merge queue, the
plate merger calculates if it can merge the press plates (LEN files)in that queue onto a layout.

A plate merge queue starts to calculate possible layouts

« everytime anew press plate enters the merge queue,
« everytime alayout was decided, it then tries a next one,
- everytime a press plate's due date is reached (or a time based on that due date),

« everytime someone decides to Force Out one or more press plates.
- every time a merge queue setting was changed (one that is relevant for calculating layouts).

Press plates that you submit to a merge queue can be merged together on a same merged plate,

« when they have the same value for plate type, resolution, imaging technology and cutting workflow,
« and when they have the same value for custom Grouping Keys (that you can set up in the Configure
tool).

1 Attention: The plate merger requires that the XMP metadata of the input LEN files contain
informationonhsize, vsize and resolution. Thisis the case for LEN files created by
Imaging Engine or FlexRip version 14 or higher.

When a merge queue decides on a layout, the assigned output workflow is started. The first task in that
workflow creates a LEN or TIFF file of that new merged plate, the last one submits that merged plate to
the chosen flexo CTP device.

A Merge Queue Per plate Type

The best reason to have several merge queues is to have a merge queue for each plate type.

Also when you have more than one flexo device, we advise to let a merge queue pick a device
automatically. This allows it to calculate more possible layouts, which improves the fill percentage
in the decided layout. Later in the workflow, the task Submit to Flexo Device sends the merged plate
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LEN or TIFF file to the device that the merger created the layout for. Learn more below about load
balancing.

Some remarks and advice when you consider other reasons to create different merge queues:

« Queues that start different workflows: For example, one queue could have an output workflow
including extra steps for quality control.

- However, a workflow itself can contain tools that decide conditional behavior (routers,
SmartNames, etc.), so we advise to first check if it is possible to have one merge queue
launching a workflow that includes different steps depending on the file's or its Job parameters.

» Queues that are not different in their queue settings but have differences in the way their output
will be imaged (CDI parameters): For example, a merge queue that only handles exposure of 2540
ppi or Pixel+ press plates.

« However, itis better to submit all these files to one same merge queue and use grouping keys to
control the files they are merged with.

Important parameters like resolution and imaging technology are grouping keys that the system
itself already uses automatically.

Learn about adding custom grouping keys in Submit to Plate Merger task on page 71.

Working with Partial Plates

When you want to use partial plates with fixed sizes, you can use the automatic workflow. Those sizes
are then predefined in a merge queue. Mind that Automation engine is not keeping track of the offcuts.

When you want to use partial plates with variable sizes, we advise to use the DFS Merger in Automation
Engine mode and create a layout for that unique size. Learn more about this workflow in Using the DFS
Merger in AE mode.

Adding Test Strips or Margins to the Merged Plate

The Plate Merger can also add test strips or margins (frames) to the merged plates. This is done viaa
set of rules that you can set up in the Plate Merger Configuration. These rules are valid for all merge
queues.

2.5.1. Adding a Merge Queue

24

Follow these steps to add a new merge queue:

1. Inthe Plate Merger view, click the # - icon (at the bottom)and choose New Merge Queue (or use the
File menu).

i = ] Note: To create a merge queue similar to another one, select one and choose Duplicate.

2. Add aName (or use the one that appears in the next step).

3. InPlate Type, click on Elto see a list of all available types(on the configured CDI devices). Select a
plate type.

4. In Merge for, define for which sizes this queue needs to calculate layouts. This is decided by the
Device, Drum and Size fields.



esko

Automation Engine

© New Merge Queue *

MName: DFH 1.70 (067)

Plate Type: |DFH 1.70 (067) Select
Merge for:
Active Device -~ Drum Size

Automatic From Device Drum Length x Drum Height

Add Remove Edit Merge Settings...
Workflow: | Merger Output WFL to CDI Select

Active: In this column, select or deselect the device that the merger can make layouts for. Learn
more below about adding extra devices to merge for.

Device: Automatic is the default setting. The merger then checks all available flexo devices and
drum sizes to calculate which one offers the best fill percentage. In case the fill percentage is
very similar for multiple devices, the merger chooses the device with the lowest queue load (see
the estimated time in its device status box).

Add or Remove extra devices. Some example cases to add specific devices:

« You have two or more CDIs of a different size and you use a plate type that is not available for
all of those. You could then make a merge queue for that plate type that only merges for the
CDlIs where it can be used on.

« You can add all your devices and de-activate the one that you know will become (temporarily)
unavailable. Mind that the merger automatically detects when a CDl is not online. However
de-activating a device it here may be useful to prevent that more jobs go to its expose
queue. For example when you know that, in a few hours, that CTP device will be offline for an
intervention or maintenance.

Drum. When you added a specific CDl in this list, the merger is automatically aware of what drum
is present when calculating a layout. A example situation to still add a specific drum in this list,
would be when you plan on changing the drum in the near future. That way, you can have a merge
queue that already makes layouts for the new drum size.

To specify a drum, double click a device / row, and in Edit Size Options, click on El in Drum Name
and select it from the list.

Size. By default, the Drum Length and Drum Height will be used (as configured on the CDI). If you
want a smaller size, type it in (for example for partial plates with a recurring size).

When a & warning sign appears next to the name of the device, hover your cursor over the icon to
read its meaning. It may be that the plate type for that queue is not recognized.
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5. Merge Settings...

© Merge Settings

Minimum Fill:

Overrule Minimum Fill:

73,0%
0 hours | 0

Press plates will be merged once the minimum fill percentage is reached.
If the minimum fill percentage is not reached at the specified time before
the due date, the press plates will be merged anyway.

minutes before due date

Rotation:  Allow 90 degree w
Auto-place Mode: Area Optimized i
Maximum Calculation Time: |30 seconds
Cut Marks: None w
Press Plate Margins: 0 mm

Press plate margins will be extended to 4 mm on the merged plate as
spon as it contains a press plate for which a text label was spedified.

Solvent Saver:

Yes

Solvent Saver Margin:
Sohvent Saver Fill: Gri
Maximum Grid Cell Width:
Maximum Grid Cell Height:
Grid Cell Gap:

Cancel

« Minimum Fill: Define the minimum fill for a merged plate.

-\@} Tip: Based on your workflow and production needs, you will need to find a balance

=0 between optimal plate usage and urgency of exposing the plates. Especially when your
merge queues often contain press plates of variable sizes, it may be beneficial to wait
until some (more) small ones are submitted to help fill the flexo plate (and so reduce
plate waste).

« Overrule Minimum Fill: <time> before the due date. Use this option to ensure that you make the
flexo plates by their due date (the time specified in the Submit to Plate Merger task). When you
need to ship the press plates by 5 PM, you could for example make sure that they are merged by 3
PM, so leaving enough time for exposing, post-processing, cutting and packing.

« Rotation: Define if you allow the merger to rotate the press plate 90 degrees on the layout.

« Auto-place Mode: Choose the main mode that this merge queue should base its calculation on:

« AreaOptimized: Layouts with the largest plate fill percentage.
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» Cut Optimized: Layouts that are optimized for manual cutting. Press plates will be placed in
'lanes'as much as possible, so enabling longer straight lines that are easy to cut manually.

» Maximum Calculation Time: Each time a calculation is triggered, this is the maximum time that
the merge queue is allowed to spend on calculating a layout. When that calculation results in
alayout, the merge queue then continues and tries again for that same period, now to make
another layout with the remaining press plates. This continues until the merge queue can create
no more layouts (with its current settings).

This time is spent on each calculation for each device this merge queue is asked to calculate for
(30 seconds then means 30 seconds for each device).

When you have many press plates, increasing this time can help to create layouts with a higher
fill percentage.

Tip: The default time is visible when you create a new merge queue.

- Cut Marks: Choose whether you want to add cut marks around each press plate (CDl or TIFF
device). These marks are identical to those offered in the DFS Merger.

Note: In the DFS-style preview of a merged plate, these marks and lines are visible as
(small) green objects.

« None.

« Cutting Marks: Small marks indicating the corners. The marks will be as long as the width of
the Press Plate Margins (with a maximum length of 5 mm). An example:

Press Plate

« Solid Cutting Lines: Cutting lines around the press plates.
« Dotted Cutting Lines: Dotted cutting lines around the press plates.

« Press Plate Margins: You can add an extra empty area around each merged plate. This is also
where the cut marks are placed.

Note: When you here add 10 mm, the space between 2 press plates will be 20 mm.

Note: When you add Cut Marks, 1 mm of press plate margins will be added
automatically. When you requested to add a text label to the press plate, a 4 mm margin
will be added to the side where the label needs to appear (unless there was already a
larger margin).
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Solvent Saver: Choose if you wish to activate the solvent saver technology. Learn more in
Working with Solvent Saver on page 89.

« No: The system will leave the waste area around the merged contents as is.

+ Yes: The system will add 100% (black) areas in the waste area around the merged contents,
so that when exposing the plate the waste area also gets exposed to UV. As a consequence
the top layer of this waste area will not be washed away by solvent in the washer/plate
processor which leads to a reduction in solvent waste or solvent saving. Using this option has
no effect on the available merge area.

{ . Note: These extra 100% black areas will be ignored when generating the cutting file

' for the merged plate afterwards.

Solvent Saver Margin: When you choose Yes, you can here specify the amount of space that
the system should keep between the black solvent saver areas and the actual merged contents
(press plates). The default and minimal value is 4 mm.

Solvent Saver Fill

+ Solid

« Grid Pattern: When merging for thick (corrugated) flexo plates, completely filling up the
waste area as one big solid could later on trigger unwanted plate curling when being

processed by the dryer. Applying a grid pattern instead of a solid area prevents this unwanted
behaviour, but also means that less solvent will be saved..

« Maximum Grid Cell Width and Height.
- Grid Cell Gap: Specify the gap that should be kept horizontally and vertically in between
the different cells when applying the grid pattern.

An example:
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6. Workflow: Select the output workflow for this merge queue. As mentioned in the introduction, this
workflow needs to start with the Create Merged Plate task and end with the Submit to Flexo Device
task. Only global workflow tickets are possible.

A

Attention: In theory you can extend this workflow with other task steps but then make sure

you still respect the required task input files in this workflow:

The layout that the merger calculates is an XML file. This first step of this workflow, the

task Create Merged Plate, needs that file as its input file.

The output file of the task Create Merged Plate (also an XML file) needs to be the input

file for the task Submit to Flexo Device.
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Note: When the selected workflow is launched for the first time, a predefined set of
workflow parameters will be injected in this workflow and can so be used by the steps in this
workflow. The values of these workflow parameters will set every time the workflow runs,

« cdi.drum: Name of the drum of the CDl as defined in the Expose application on the
Grapholas PC. Not available for TIFF devices.

« cdi.id:Internalid how the CDI or TIFF device is configured within the Automation
Engine server.

« cdi.name: Name of the CDI or TIFF device as configured in the Devices View.
« CutWF: Name of the cutting workflow used in the Submit to Plate Merger task.
+ ImgTechn:Imagingtechnology setin the Submit to Plate Merger task.

« mg.mergerxml: URL of the input file of the workflow.

« mp.type: Plate Type as configured in the Merge queue.

« mqg.name: Name of the Merge Queue.

« PlateType: Plate Type as configured in the Merge queue.

+ Resolution: Resolution of the Merged Plate.

« User defined name of the grouping keys as defined in Configure > Plate Merger > Name
Custom Field.

7. Click OK to confirm and create the merge queue.

Note: You can also select an existing merge queue, right-click or click # ~ and choose
Duplicate to create a similar queue.

2.5.2. Managing Merge Queues

30

Pausing a Merge Queue

Attention: When your setup is a standalone Device Manager (i.e. not a full Automation
Engine), the merge queues will always be paused. You will also not be able to Hold or Release
items in these queues. Contact Esko to learn how to extend this functionality.

Select a merge queue, right-click or click # ~ and choose Pause Merge Queue to stop a merge queue

from trying to create layouts. The icon of the queue then changes to #. Press plates can still be added
or removed, but no automatic merging will take place.

Choose Resume Merge Queue to activate the queue again (E).
Pausing a merge queue is interesting in these cases:

« When, during busy production, you want to change some settings of that merge queue.
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When you are used to work with layout proposals, you sometimes want to pause the queue while
investigating the proposals.

When you use the DFS Merger in Automation Engine mode, the DFS will automatically pause the
merge queue that you selected there.

Tip: There is no need to pause a merge queue because a CDI is down or offline. The merger
automatically detects this device status and will resume merging for that device as soon as the
CDl is available again.

Viewing and Managing Queue Entries (Press Plates)

To define which columns you wish to see, go to View > Select Columnsiin ... or right-click on a column
header and (de)select the type. You can also drag columns to a different position.

Select an entry to see a panel with information on the press plate (LEN file), including its submit date
and due date.

The plate merger works fully automatic but there are some manual interventions you can still do on
selected press plates:

Click @ or right-click and choose Hold to prevent the merger from considering these entries.
Click @ or right-click and choose Release to release these entries that were put on hold.

Click © or right-click and choose Force Out to force the merger to create a layout instantly
including the press plate(s) you forced out. In this case, the queue's setting Minimum Fill is ignored.
The merger also tries to add other press plates to that layout (that were not forced out but were in
'waiting' status).

The merger creates as many layouts as needed for all the forced out entries and then falls back on
its usual calculation schedule.

Click @ or right-click and choose Delete to remove the press plate from this merge queue.

Click @ or right-click and choose Info to see the XMP metadata of the press plate's LEN file.

Tip: The dedicated view Press Plates offers more information and functionality on press

‘ plates.

Right-click an entry and choose Go to File to open the Files view and see the related LEN file
selected inits (Job) folder.

An entry in a merge queue can have these statuses:

Waiting for the merger to be placed on a layout.

=10n Hold, not available for the merger until released again.

Forced Out. The queue entries that you forced out are still available in the queue with this status
until they disappear a few moments later (once the merger finished calculating which other 'waiting'
entries could also be put on the layout).

# Rejected. Hover your mouse over the icon to read details. When a press plate remains stuck in a
merge queue, it most probably rejected by all targeted devices because of one or several of these
reasons:

+ The press plate is too big for the device.

« The press plate’s resolution is not available on the device.

« The press plate’s imaging technology is not available on the device.

« The press plate’'s imaging technology is not available for the plate type on the device.

« The press plate contains HD screens and the device does not have an HD Flexo license.
« There are no devices available to merge for.
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« The plate merger's output folder is low on disk space.

« The selected cutting flow file does not exist anymore.

« Thereisanunsupported drum installed. Sleeve and pre-mount drums are not supported.
+ Thereasonis unknown.

In some of the above cases, the reason for rejecting the item can disappear. For example: When a
CDI that was off-line becomes available again, the merger automatically detects this. So the next
time the merger calculates possible layouts, the items that were intended for (only) that device will
again change their status from 'rejected' to 'waiting'.

About Load Balancing

As mentioned above, when you allow a merge queue to create a layout for more than one CDI ("Device:
Automatic”), then, if the plate fill percentage is very similar, the merger will choose to create the layout
for the device with the least work to do (based on the estimated time mentioned in the device's status
box).

This load balancing is not available for TIFF devices. When it has to choose between TIFF devices there
is currently no way to predict which one the system will choose.

(f ’ Note: If the automatic merger has to choose between a CDI and a TIFF device (in a case where
they already have a similar waste percentage), it will choose the CDI device.

When the due date is more important than waste reduction

The plate merger's focus is on making layouts with the least waste. When submitting press plates, you
can also define a due date.

Follow these steps to make layout and output decisions (also) based on this due date:

In Plate Merger view, select a merge queue and select all entries in that queue.
Click @ to put them all on hold.

Sort the list on due date by clicking on the header of the column "Due Date".
Select those that, for example, must be delivered within the next 3 hours.
Click @ to release these entries.

Optionally, go see the layout proposals of this queue (unless the queue's already decided on a layout
and created merged plates).

R N

Managing the Merger's Output Files

The plate merger creates many files in the folder that was defined in the Plate Merger item in the
Configure tool. You can there also define when these data should be cleaned up.

Plate Merger Configuration

(f Note: Learn about the Plate Merger concept and View in the chapter Flexo CTP Device
Workflow.

To configure your plate merger, go to Pilot > Tools > Configure > Plate Merger.

« Tab'Setup'on page 33
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« Tab'Reporting' on page 34
« Tab 'Test Strips'on page 37

« Tab'Margins'on page 40.

Tab 'Setup'’

oo W W e
File Edit

-4 Gang Run Printing &

3 Global Vision | Setup | Reporting | Test Strips | Margins|

'* Imaging Engines Output Folder: |file://AEserver/AdminData/DFS_Temp >
: JNZ?:.IS [v] Automatically delete files in subfolders (except reports)

[ % Notification Clean up after |20 | days and 0 hours
44 Odystar

] MName Custom Field 1: |5hipping | [/] Use as grouping key

(-4 Preflight Tools

; Il Name Custom Field 2: | [TUse as grouping key
% Printing Methods

I'-H % Processing Preferences Name Custom Field 3: | || Use as grouping key
'9{ Products MName Custom Held 4: | || Use as grouping key
4 Proof Servers E . 3 | i

4% SAP Servers Name Custom Field 5: |Use Test Strip || Use as grouping key
ul # SETP Sites Use the Customer field as grouping key

o 4 Scripts

# Secure Web Proxy Cutting Workflow: |DFS Plate Ready for cutting (Cles || Select |
-4 Shuttle ol This workflow is executed when a merged plate is ready for cutting.
Jdoom

« Output Folder: This folder stores files created by the plate merger, in many subfolders. These are
the files you see when, in the Merged Plates view, you use the feature Open in Browser.

The large LEN files that were created by the Create Merged Plate task also resides here. In case of
CDls, their DFS Exposer application downloads them from this folder when he starts exposing. For
TIFF devices, the large layout TIFF file has its own output folder.

A Attention: Do not manually manage any of the files in this folder or its subfolders.

Click m to change the default path to a custom one.

Attention: When changing this folder, make sure there are no more files in there that are
used by the merger.

+  When you select Automatically delete files in subfolders (except reports), then define in Clean
up after after which time you want all these temporary files to be deleted (merged plate LEN file,
GIFs, XMLs, etc.).

Attention: A merged plate cannot be resubmitted to be exposed again when its related
files in these folders have already been deleted.
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Name Custom Field 1-5. Many of the Flexo Device related views show columns. If you want to use
any of these b custom columns, enter their name here. The value of custom fields can be set in the
Submit to Plate Merger task.

« Select Use as grouping key if you also want to use that custom field as a grouping key in the
plate merger's merge queue. Grouping keys limit the plate merger's freedom to decide which
press plates can be considered to be placed on a same merged plate.

Select Use the Customer field as grouping key if you want to avoid that press plates from different
customers (when specified) are placed on a same merged plate.

Cutting Workflow.
When a merged plate was exposed on a CTP that will be cut on a cutting table, the here selected
workflow will automatically be started.

This workflow is launched on the XML that contains the cutting information that was originally
defined in the Submit to Plate Merger task.

«  When you use a Kongsberg table, the workflow needs to submit that XML file using the Submit to
Kongsberg Table task.

« When your cutting table is not a Kongsberg, you need to create a workflow that selects the
cutting instruction file itself and then forwards that file to the cutting table. This can be done by
using the Select Referenced file task. An example:

ﬁc b: -;-g }>

Start Select @ Copyor Move File oK
Referenced to Cutting table
Cutting File in
XML layout file

Learn more about cutting flexo plates on a Kongsberg table in the chapter Kongsberg Production
Workflow.

Tab 'Reporting’

) Configure ==

File Edit

[t 5 Nexus

Reportin \T i ;
[+-%%# Notification Setup| Reporting | Test Strips | Margins

g}'ﬁ' Odystar When a merged plate |s submitted to a flexo CTP device: Claar || Sslact
+ z Is When a merged plate is exposed: Clear || Select
{#% Printing Methods When all press plates for a job are exposed: Clear || Seket
[tH-3# Processing Preferes when a merged plate is cut: Cloar || Selact
(¥4 Products

I~3 Proof Servers

4 I I
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These 4 fields allow to automatically launch a workflow at those specific moments. These workflows
serve to send feedback to external systems, to inform them on statuses or deliver information that
helps cost calculation.

E b ] Note: In stead of waiting for workflows to send this information, an external system can also
get such information on demand. Lean more in External Systems Requesting Information on
page 35.

The input file for these workflows is decided automatically. These input files are XML report files
containing specific information that is valid at that time.

E b ] Note: These XML report files are picked up from a subfolder 'Reports' of the Output Folder
defined in the tab 'Setup'. These files are not deleted by the cleanup tool in that panel. You
could choose to have the workflow that you launch on them also delete them at the end (or
after a few months for example).

«  When a merged plate is submitted on a flexo device : This is each time a Submit to Flexo Device
task sends a merged plate to a CDI "Exposer' queue or writes a TIFF in the output folder fora TIFF
device. This report is also available as a link in the task details of such a Submit to Flexo Device task.

- When amerged plate is exposed: Each time a merged plate is exposed, this XML can deliver
information about the device, plate usage, waste, etc. This workflow is also launched when the
merged plate was cancelled (removed from the CDI's expose queue). In case of a TIFF device, the
state 'exposed'is already set right after the TIFF arrived in the output folder.

+  When all press plates for a job are exposed: When all plates of a press plate set are exposed (or
cancelled), this XML can inform on which job, which plates, when, plate usage, etc. This XML can for
example describe the plate usage by the job's 5 press plates that ended up on 3 different merged
plates.

«  When amerged plate is cut: Learn here how and when the CDI workflow communicates plate
cutting instructions to a Kongsberg cutting table (iPC). The workflow that you define here will be
launched each time such a flexo plate was cut. This signal to launch a workflow can also be the case
when the plate was exposed on a TIFF device and later cut on a Kongsberg table.

Learn more about these XMLs in Interpreting the Reporting XML files on page 91.

The most simple workflow to launch on those XML files could be a "Copy or Move File" task to make that
XML file available to another system. Here is an example of a more advanced workflow to feedback
such events to a business system:

O & L L M
e (]
Start Map Data Interact with Web Ok
Senice

IE ] Note: Learn more about delivering information to external systems in this dedicated chapter.

External Systems Requesting Information

Concept

External systems (MIS, ERP, ...) are especially interested in how much flexo plate was used for a job.
They use this information to help decide the cost for that job. In stead of waiting for workflows to send
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them this information, external systems can also get this and other information on demand. Some
want to see what is still waiting in the merge queues. Some want to see the overall status of the CDI
device(s).

1. Requesting info on how much plate was used for a job (cost, statistics)

An external system can do HTTP calls to request status information of all Press Plates of a specific
Job. To do this, the external system needs to execute an HTTP 'GET request. It will get an XML file as a
result.

Syntax:

[l Tip: Asatest, you can also execute HTTP requests via a browser.

+ Input:
Syntax of the URL to HTTP-GET the XML report:
http://<name-of-AE-server>:4412/FPL/job/<jobname>

. <name-of-AE-server> =the name of the Automation Engine server (the master server).

+ <jobname> =the Job Name of the job of which you want the XML report.

Example: http://<name-of-AE-server>:4412/FPL/job/1234banana

(f ’ Note: To get an XML where the list of Press Plates are listed per Press Plate Set, add the
parameter 'groupperset=1". The "Images" (Press Plates) within the XML element 'Images'
will then be grouped per 'ImageSet'.

Example: http://<name-of-AE-server>:4412/FPL/job/1234banana?
groupperset=1

« Output:

An XML report describing all Press Plates related to that Job, including their current status.

2. Requesting info on what is still waiting in the merge queues (job load)
The amount of press plates that are still in merge queues also predict the work load for the next hours.
Syntax:
« Gotohttp://<name-of-AE-server>:4412/FPL to see aninformation page.
« There, in the topic Live PlateMerger queue Updates(/M0), click the link to see the 'Server

Sent Events'. The 'Server Sent Event' source can be reachedat http://<name-of-AE-
server>:4412/MQ/SSE . An example:
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r’ B PizteMerger-queues-55E x
& C | ® eawl6dI271:4412/INFO/mqsselhtml edl®

l
Live PlateMerger queue status updates

MergeQueue State Paused Queue-Length Finished
DFH 1.14 (045) idle paused 4
DFH 1.70(067) idle active 0
Lintec 124 wdle paused 0
Next Generation Laserpoint ITidle paused 0
Round Classic wdle paused 0
WS 0.73 (029) idle active 0
Event Log
Received:
13:30:12 [{"IDLE":"TRUE","QUEUELENGTH":4,"PAUSED":"TRUE","NAME":"DFH 1.14 (045)"},
{"IDLE":"TRUE","QUEUELENGTH":0,"PAUSED":"FALSE","NAME":"DFH 1.70 (067)"},
{"IDLE":"TRUE"."QUEUELENGTH":0,"PAUSED":"TRUE","NAME":"Lintec 124"},
{"IDLE":"TRUE","QUEUELENGTH":0,"PAUSED":"TRUE","NAME":"Next Generation Laserpoint II"},
{"IDLE":"TRUE","QUEUELENGTH":0,"PAUSED":"TRUE","NAME":"Round Classic"},
{"IDLE":"TRUE","QUEUELENGTH":0,"PAUSED":"FALSE","NAME":"WS 0.73 (029)"}]
13:30:02 [{"TDLE":"TRUE."OUFUELENGTH":4."PATUSED":"TRIUJE"."NAME":"TOFH 1.14 (045"} -

Per Merge Queue, the following information is returned:

«  NAME : Name of the merge queue

« |IDLE :"TRUE"when the merge queue is not merging/calculating proposals
« |IDLE : "FALSE"when the merge queue is merging/calculating

« PAUSED : "TRUE" when the merge queue is put on hold

« PAUSED : "FALSE" when the merge queue is active

« QUEUELENGTH : Number of entries currently in that merge queue.

3. Requesting info from the CDI device

HTTP calls can also be used to retrieve information about the CDI Device status. This enables to show
what you see in the CDI Device view in your own custom dashboard.

Learn more in CDI Device Status in an External Dashboard on page 13.

Tab 'Test Strips'

Concept

You can here define which test strips that the plate merger needs to add to the layouts it makes. These
test strips are LEN files that you created earlier.

Note: LEN files can be used as test strip when they have sufficient XMP data. When your LEN
2= files are made by FlexRip 7 or older, contact Esko support for help.
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—@— Note: Also when the merged plate will be a TIFF file, the test strip needs to be a LEN file.

You also set up rules that define when which test strip needs to be added. These rules are valid for all
merge queues.

A test strip's position and orientation on the layout can not be predicted. An example of where it could
be placed:

@ Note: When calculating layouts, the plate merger first puts the test strip on the trial layout and
== then checks how to fill the remaining area. The surface of a test strip is also calculated when
calculating the required fill percentage.

Attention: On a merged plate, test strips are not counted as press plates (which together
represent the used plate area). This means that adding test strips increases the waste area of a
merged plate.

3

How to Add a Test Strip Rule

| Setup | Reparting| Test Strips Margins|

Registered Test Strips:

File Name - Size Resolution Submit Date  Folder
2400 Polymer wedge Ko... 350.074 x ... 2,400 ppi 2/23/17 4:... file://egsbe...
TestStrip_Default_2000... 320.865 x ... 2/10/17 12... file://home...

TestStrip_Default_2400... 320.855 x ... 2,400 ppi 2/10/17 12... file://home...
TestStrip_Default_2540... 320.86 x 2... 2,540 ppi 2/10/17 12... file:{/home... ™
Details

File Name: TestStrip_Default_2000ppi.... ll_l---_
Submit Date: 2/10/17 12:28 PM
Size: 320,865 x 25.514 mm

Dacalutiom: 3 A0 mei

Add J Remove

Define rules to add a test strip to a merged plate:

m

Active Name Test Strip
[]  Default rule for 2000 ppi TestStrip_Default_2000ppi.len -
||  Default rule for 2540 ppi TestStrip_Default_2540ppi.len |_
[ Add || Remove || Edit | | MoveUp || Move Down |

The first matching rule will add the corresponding test strip to a merged plate.
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1. First register the test strip file. In Registered Test Strips, click Add, browse and select the LEN file.
The system will create a thumbnail and show you its Details.

2. Then define arule when this test strip should be used. In'Define rules ..., click Add and Name this
rule.

3. Set the Conditions that need to apply for this test strip to be placed on the layout.
The most typical condition for such arule is to add a test strip with the same resolution as the other

press plates on the layout. Other conditions usually are imaging technology, plate type or adding
them customer specific.

E b ] Note: Creating these rules is very similar to creating filters in the Pilot. Learn more here.

See this example where one of the custom fields (that is also used as grouping key) helps to decide
if this merged plate needs a test strip or not:

© Rule Properties ﬁ

MName: |TestStrip_HD_4000ppi

Place test strip on merged plate that match the following conditions:
Resolution = equals ~ |4000 ppi
Any > of the following are true

Imaging technology ~ is ~ Full-HD

Imaging technology = is ~ Pixel+

[ ||

Imaaging technology = is ~ "XPS Crystal UV"
None ~ of the following are true
Use Test Strip = is = |no

Test Strip:  TestStrip_HD-Flexo_4000ppi.len Clear | Sulect
Label: HD4000-[Merged Plate Name] 4]
[ Ganca

4. Select the LEN file for this rule (from the list of the ones you registered earlier).

5. Optionally, add a Label to this test strip. This text will appear along its long side. A margin is created
automatically (on the side of the test strip where the label is added).

[ ( ] Tip: It may be useful to add the plate name as a label above the test strip. This way, after
cutting, you can still find back which strip was used for which press plates. For example,
when you want to check a complaint on a certain press plate, then follow these steps to find
the test strip that was also on that same flexo plate:

1. Inthe Press Plates view, look up the press plate entry (filter via via job, orderid, id on
Plate, file name, etc.)

2. Right-click this entry and choose Go to Merged Plate.

3. Write down the Name of this merged plate. It is mentioned top right and has an
extension .par.

4. Use this name to find the test strip in the (physical) archive of your used test strips.

6. Click OK.

7. Click Move Up / Down to define the order in which multiple rules need to be executed. Put specific
ones at the top and general ones at the bottom.

8. (De-)select the toggle next to a rule to (temporarily) de-Activate that rule.
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9. Use File > Save to save your settings. These rules are then instantly picked up by all plate merger
gueues.

Tab 'Margins'

Concept

This tab allows to add extra margins around merged plates created by the Plate Merger. You can add
different margins per top, bottom, left and right side.

Note: DFS applications refer to these margins as 'Frames'.

Rules

You can define these margins through alist of rules. Each rule can add margins for a specific
combination of a device and a drum size.

The first rule that matches will be used by the plate merger and no further rules will be checked.

Use the Add Up / Down buttons to define the order in which the rules should be checked.

~@F| Tip: Alastrule could be one for Any Device, Any Drum and Any Merge Queue. The plate merger
will use this one for all situations that were not specified in any rule set above.

© Configure - a x
File Edit

[T EJ Locations
+- 0 Hotification Setup Reporting Test Strips Margins
Y Passwords
@
- (&) Printing Methods
+ E.: Processing Preferences Any Device Any Drum DFH 1.14 (045) - CCC 5, 5, 5, 20 mm (exposed)
[ Products. Any Device Amy Drum Any Merge Queus 10, 10, 10, 10 mm
+ [0 SFTP Sites
(&1 Track Edit Session
[ viewer
¢ [Z] WebCenter Sites v

Margins of the first matching rule will be applied to the layout:

Device Drum Merge Queus Margin

Add Remove Edit Mave Up Move Down

Defining a Rule to Add Margins
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© Add Merged Plate Margins b4
Device: |Any Device v
Drum Name: Any Drum ~

Merge Queue: CDI DFH 1.14 Flate L.. v
Margins: 3 10 mm
=l | 10 mm
] | 10 mm
1 20 mm|
Expose right margin

==

- Device: Set this rule for any device or select a specific one.
« Drum Name: Set this rule for any drum or select a specific one.
« Merge Queue: Set this rule for any merge queue or select a specific one.

« Margins: Type the wanted margins.

About their orientation: The top, bottom, left and right sides match to the orientation that is shown
when viewing the merged plate as shown in these places:

« inthe DFS application "Exposer”, in the Info dialog of that queue
« inthe Pilot's Merged Plates view,

« inthe preview dialog that opens when you select an entry, right-click and choose Open
Preview

« inthe previews that, when you select an entry, are shown in the right side panes.

- Expose right margin: When enabled, this adds a right margin that will be exposed as a solid area (by
default 20 mm). This option is used by users of CrystalCleanConnect, an automated platemaking
device.

An error will occur when enabling this option on a plate that is not its full size.

2.5.4. Working with Layout Proposals

Concept

When a merge queue has decided on a layout, the output workflow creates a merged plate.

However, there are several cases when you might want to see which Layout Proposals this merge
queue has calculated but rejects as a final merged plate because they are not fully conform to the
queue's Merge Settings (the required minimum fill %).

In the view Plate Merger, right-click any merge queue and choose Show Layout Proposals (or use
Alt/CMD-Down)to open a view that shows the layout proposals . You can there choose which one you
want to 'force' Expose. You can even edit a layout proposal before exposing it.
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s

1] Spark 5080 (2) Customer... «  File Name Submit Date  Ink State
1] Spark 5080 QA TestStrip_Default.. 3/14/17 9:0... Black
“an Spark 5080 WD SuperPrint 01_shrek_Y.len 617 6:58... Yellow
L] T .
MNew Merge Queue Crrl+N /6/17 6:58... Magenta
Open 3/6/17 6:58... Black

L 3/2/17 12:2... Cyan
3317 3:26... Black
Pause Merge QIJEL.IE' o 3217 12:2... Black
3/2/17 12:2... Magenta
32017 12:2... Yellow
Delete 3/3/17 3:26... Cyan

Duplicate

I Show Layout Proposals Alt+Down I

[ s R O s s

These are typical cases where you may want to see and or change these layout proposals:

Why is this press plate still pending in the merge queue?

You typically have double-checked the settings of the merge queue, but you still wonder why the
workflow does not continue.

| want to understand in detail how this merge queue decides a merged plate.

Looking at the (rejected) layout proposals helps to understand how the settings of this merge queue
affect the layout calculations it makes.

As a CTP operator, | want to see all layout proposals for a specific device, so | can choose which
merged plate to expose next on this device before its queue runs empty.

Evenin a workflow where you expect the best layout proposal to be chosen automatically, a CTP
operator might still want a moment of visual control over which proposal should become the
merged plate.

| want a visual overview of layout proposals based on their urgency.

Sometimes, the urgency of a plate is more important than its waste percentage and you manually
want to decide this priority.

| want to manually inspect or optimize the laser beam count of a layout.

Sometimes you can manually optimize the speed in which a plate will be exposed by re-arranging
press plates on the layout.

Inspecting and Exposing Layout Proposals

This view shows the layout proposals of one or all merge queues. You can inspect them. You can
choose to expose a selected one. You can not delete a layout proposal. The next page explains how you
can view a layout in detail and possibly make changes before exposing it.

Attention: This view does not show all possible layouts ; there could easily be millions of

combinations. It only shows the best proposals, the ones with the least waste.

The top barin this view is in a light yellow color. This can help remind you that you are looking at
proposals, not at Merged Plates.
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[ Plate Merger + G G 4 g |
| £ Merge Queues(- ] Spark 8 press plates . Request Auto Merge | Resume Merge Queue
Spark 2530 6 - (1) Device: Spark 5080

L (,. Mate Type: DFH 1.14 (045) |

Dirum Mame: V5080EC3
Resolutlon: 2,000 ppl
Size: 2,082 x 1,255.94 ... |

o
‘ Grouping: 2000, DFH 1.14 (...

Test Strip: --
00 ¥ 621.18 mm Contains: 8 press plates
Today 5:00 PM G Press Plates: 01_shrek_C.len
42._1% waste 01_shrek_K.len
Spark 5080 6 ? (2} 01 Shl'EK_MJEﬂ
k. 01_shrek_¥.len
Expert_Box_pl_...
: 2 : Expert_Box_pl_...
A () B i i
L 0 0 WO Expert_Box ..
== Expert_Box_pi_...
- ENPERT )
4 ) 3
O
- 3 — |
g Ea
2,032 x 1,255.94 mm 2,032 x 1,255.94 mm
Today 5:00 PM Today 5:00 M
8 22.6% waste 39.5% waste
1 of 3 selected Sapver: rdvimael?  User: wde F0 & l

1. Click <Merge Queues (or use ALT/CMD-Up)to leave this view and go back to the list of press plates
of this merge queue.

Note: To avoid navigating back and forth, create an extra Tab to view both modes (File >
2= New Tab).

2. Name of the selected merge queue. The icon indicates if the queue is active or paused.

« Double-click it to open the queue's settings.
» Right-click it to select a different merge queue. This avoids having to navigate away from this
view. You can also select this view for All Merge Queues.
3. This number shows the amount of press plates in this merge queue (no matter what state they are
in).
4. Click 'Request Auto Merge' to manually trigger the merger to (re-)calculate layout proposals.

‘- Tip: When new press plates are submitted when the merge queue is paused, this view will
“  not change. You can then click this button to trigger a new calculation of proposals.

Note: While the merger calculates, this button changes to '‘Cancel Auto Merge'.

43



esko

Automation Engine

Tip: When, after a short while, you still do not see any change in the proposals, go see
the list of entries for this merge queue and check any error message(s) in their details
pane. They could show that entries are "too big"orrequest"unsupported imaging
technology".

5. Resume Merge Queue or Pause Merge Queue: A shortcut to pause or resume this merge queue
(without leaving this view).

6. Layout proposals can be shown in several ways.

Tip: Usethe | slider in the Pilot's top bar to change their display size.

Tip: Use the arrow buttons to navigate through the proposals.

Right-click anywhere in the overview area and choose from:
- "Arrange by"

- by Device(asin above screenshot): Grouped per device. These are the devices that are listed
in the settings of the Merge Queue, in "Merge For".

« by Size: Grouped by size of the layout.

« by None: This shows all of them, now no longer in one horizontal list but in a continuous
display using any rows below.

« "Sort by": Choose which layout is shown first:

« Waste: The one with the smallest waste percentage.
+ Due Date: The most urgent one.
« "Organize by Layout". Identical layouts are then shown in stacks that you can browse through.

This is especially useful when you have multiple flexo devices that are using the same plate size.
You then also typically arrange the view by plate Size.
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{ = Note: An example: You have two CDI Spark 5080 devices that use plates with the same
== size. You asked to calculate layouts for both devices. You switched on 'Organize by
Layout' and '‘Arrange by None':

1,870 x 1,000 mm

= 4123 FM bf 1/ 4L IIFM
40,9% waste 40.9% waste

When you click on the arrows beneath the stacked layout, a next layout in this stack is
shown. This other layout however will typically look identical. This is because the layouts
in a stack have the same layout of the same press plates.

What typically does change in a stack of layouts is the name of the device: these are
identical layouts made for more than device.

7. The amount of layouts (or layout stacks) shown in this arrangement (device/size).
8. The total amount of layouts (or layout stacks) shown for this merge queue.
9. . Device name(when not viewing 'Arrange by Device').

- Layout size (when not viewing 'Arrange by Size'). If this layout is chosen to be exposed, this is
then the size of the merged plate.
» Due dates, shown in red when it is overdue.
+ Waste percentage.
10. Information about the selected layout proposal. Learn more in Merged Plates.
+ Beams: This shows the average beam count for the entire layout. This gives an indication how
long it will take to expose this layout.
- Grouping: These are the values of the parameters that were involved in grouping these press
plates onto a same layout (both system level and custom grouping keys).
11. As mentioned above, not all layout proposals are shown, only the best ones.
The top screenshot on this page shows such an example:
- The selected proposal (bottom left) for the Spark 5080 shows that here are 4 press plates for the
'Shrek’job: C, M, Y, K.

« Above, on the smaller plate for the Spark 2530, only one proposal is shown, including only C, M,
K. There are other layout proposals for this smaller plate, but showing those here brings no extra
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value: Or they contain a same amount of press plates from a same set, or their waste percentage
is(much) higher. Therefore, in this example, only this one best layout is shown.

Choosing to Expose a Layout Proposal

When you want to output a layout proposal, right-click it and choose Expose.

This will remove it from this view and start the assigned output workflow for this merge queue

(creating a merged plate and sending it to the CDI).

When you choose to expose a layout, the current list of proposals disappears. This is because the plate
merger immediately recalculates new layout proposals, now using the left-over press plates.

(f ’ Note: You can change a proposal before exposing it. Learn more below.

Inspecting and Changing a single Layout Proposal

Detailed View of a Layout Proposal

In the overview of layout proposals, double-click a proposal to open it in a different view where you can

inspect and change it.
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1. Press<Layouts to go back to the overview of layout proposals.
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i g I Attention: When you leave this view, any possible changes to this layout proposal will be
lost.

Click Pause Merge Queue or Resume Merge Queue to pause or resume this merge queue. Similar
buttons are available when you are viewing All Merge Queues.

The Info button shows a right pane with details about the layout proposal (top) and about the
selected press plate (bottom).

The Press Plates button shows a right pane that assists you when manually placing the press
plates. Learn more in Working with the List of Press Plates on page 51.

This is the width and height of the layout proposal. Use the numeric fields (including calculator) or
the cropping icons.

Thisis the X and Y position of the selected press plate. Use the numeric fields (including calculator)
to re-position it or use the icons to center it on the layout. Learn more here.

This is the beam count for this vertical lane of the layout. Learn more in Information on Beams used
per Lane of Press Plates on page 48.

This indicates how many (selected) press plates there currently are on this layout.

Notice the different colors for sizes and margins:

1.
2.
3. Merged plate margin (darker pink).
4,

Drum size (grey). This grey area is not visible when the layout is the size of the drum.
Layout size (when exposed, the size of the merged plate)(pink).

Press plate margin(grey around press plate).

In this mode, you can measure details, inspect beam counts, change the layout and choose to expose it
from this view.

Note: Editing features that are not available here might be part of the separate application

"DFS Merger"(for example the tools for a PlatePatcher workflow).
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Information on Beams used per Lane of Press Plates

i g I Attention: Information on CTP laser beams is only available for CDI devices.

Sometimes, the urgency of a plate is more important than its waste factor. To help judge the speed
that the plate will exposed with, you also see the predicted amount of laser beams per 'lane’ of press
plates.

[H Flabe Merger + 1
| % Laoats Flasume Merge Queue
Info_|| Press Plates
Device: Spark 5080 (2) =

Plate Type: DFH 1.14 {043)
Owurn Mams; WS080ECT

Fesolution: 2,000 ppl

7o 2,032 % 1,255.94 mm

3{2§17 5:00 PM

= 12.2%
Beams: 6.42

Grauplng; 2000, DFH 114 [(43), yes, Standard

;‘.I ;2-; f&u :';F' = Test Strip: TestSrip_Defauls_2000p0i len

[ T T T s }' '. T : 1
seee s @7 W — -
i & X mﬁ ﬂ!w:; ) H: | 1255.94 mm =T

el el =
s g \'.?-J gt File M Expert_Box_pl_C.len
i file:/ e 10 267 WDE-AE-DATA/ ...

¥

o QJ ok - -
P = Sire: 817.6 % 391,401 mm

Ink: Cyan

ner Mame: SuperPrint
aibmit Date: 31F17 10:44 AM

[uee: [t 32F17 5:00 PM u

LS ¥l
Beams; 13, 12, 10, 10, 9, 4
o all bessens

"ﬂ"‘.‘ "ﬁ;J ‘—%‘lJ %)

1 of B selected Server: rdvmael? Usarwde 10 A&

1. Inthe center of each press plate, the number in the black rectangle indicates the maximum amount

of beams that this device can expose this press plate with. For example .

Note: This beam count is based on the angle, ruling and resolution of the LEN file.

| @

@ Note: No number is shown when the press plate has no screened data or when its XMP
&= metadata does not mention screeninginformation.

Select a press plate to see more info in bottom part of the details pane on the right:

« Beams: This list all possible beam counts for the selected press plate.

« Select Allow all beams when you want the beam count only to be based on resolution.

Note: Inthe "DFS Merger”, this option is called "Testform".

i g I Attention: Enabling this option can cause moiré on the exposed plate.

Some examples cases where this can be useful:
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«  Whenthere are only solids in the press plates (0 or 100 %).

« When you do not want the presence of a halftone object to slow down the exposing of the full
plate. This could be animage in a test strip or for example a small image that was triggered
by a SmartMark. The quality of such images may be less important, so you do not want them
to slow down the exposing.

« When exposing a plate with only test charts where the halftone datais not important.

At the bottom of the layout proposal, a small number shows the highest possible common beam
count for all press plates in that specific vertical lane (in DFS referred to as 'Stripe’). A random
colored horizontal line above this number indicates the width of the lane.

This number is re-calculated every time the layout changes.

{ ' Note: Sometimes, by swapping 2 press plates, you can increase the beam count for a lane,

' and so expose the plate faster.

When this view cannot detect or calculate a number, it will show the default minimum of '4". An
example: In above screenshot, the press plates of the 2 of the wine label repetitions (bottom left)
have no screened data and so the beam count for their lanes is '4". Solve this by selecting them (one
by one)and selecting Allow all beams.

Note: The beam count shown here is only a calculated prediction. The real beam count used
during the exposing is decided by the DFS when it reads the LEN file of the merged plate. This

view could for example show '4' because of press plates without screening, while the CDI itself
can decide it can and will be higher.

Changing a Proposal before Choosing to Expose it

This view not only allows close inspection of a layout proposal but you can also make changes to its

con

tent or to its size. However, you can not save these changes. These changes only serve to make a

more optimized layout right before you choose to Expose it.

0

Tip: All changes can be undone (use CTRL/CMD-Z).

. Note: To select multiple press plates:
]
+ Hold CTRL/CMD while selecting.
« Clickand dragan area. All press plates touched by this area will be selected.

« Use CTRL/CMD-A to select all.

Functionality:

« Moving press plates:

By dragging: Select one or more press plates and drag them to another position. The snapping
tool helps you to position them accurately (see the assisting blue lines). A dark red color
indicates an overlap with other press plates or any position outside the layout area.

{ ' Note: When multiple press plates are selected, the movement is done on the bounding
]

box of the selection.

Learn about extra possibilities with staggered press plates on this next page.
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Numerically: Select one or more press plates, enter a new value for X or Y in the details pane and
confirm by pressing Enter or Tab.

When multiple press plates are selected, the position can be specified in an absolute or relative
manner:

«  When the entered value starts with + or -, the value is interpreted as a relative value. All
press plates are moved, relative to their current position.

«  When the entered value does not start with a sign, the value is interpreted as an absolute
value. All press plates are then moved to the exact position that was entered (and are
probably overlapping).

Centering: Select one or more press plates and, in the X or Y fields, click on % (center
horizontally) or &= (center vertically).

Note: Press plates that overlap or are moved outside the layout area are highlighted in red.
Warnings will appear when you then choose to Expose.

Rotating press plates:

Right-click your selection and choose Rotate to rotate them 90 degrees clockwise or, when they
already were rotated in this view, counter clockwise.

/i Attention: Before rotating, the system checks two options used when submitting these

press plates to the plate merger:

«  When one or more press plates were submitted with a forced rotation (0 or 90), a warning
appears. You can choose to Rotate Anyway or Cancel this request.

« When you submitted these press plates without allowing different rotations, the plate
merger might have decided to rotate them all, as a group. When such a group rotation is
detected, you will be asked to choose between Rotate Anyway (only those you selected),
Group Rotate (also those in the rotation group) or Cancel.

Swapping press plates:

Press CTRL/CMD and click to select 2 press plates. Then right-click this selection and choose Swap
to make them swap position. Their rotation will not be changed.

Removing press plates:

Right-click your selection and choose Remove to remove these press plates from this layout
proposal.

Changing the size of the layout area:

Automatically: Cropping the merged plate. You can crop the (pink) layout area to fit to the area
taken by the press plates. This allows you to create a partial merged plate (in case you choose to
expose that layout). All required margins will remain.

To do this, click the crop buttons in the W or H input fields:
« Click ¥ to crop and fit the layout horizontally.
« Click #to crop and fit the layout vertically.

Numerically: Enter a new size in the W or H input fields. Remember you can use these fieldsa s a
calculator.
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Right-click a press plate and choose Go to File to see the LEN file of press plates selected in the

« Right-click a press plate and choose Info to open the dialog showing the XMP metadata of this LEN

file.

« Right-click a press plate and choose View to open the related LEN file in the Viewer. This is only
possible when prepared view data is available. Learn more in Viewing RIP data.

« Right-click anywhere in the layout and choose Expose to start the output workflow for this layout

proposal.

Working with the List of Press Plates

« Intheright pane, the button Press Plates lists the press plates that were placed on this layout

proposal.

In the list, the icon L below their thumbnail indicates that this press plate is still present on the
layout proposal. Those without this icon were manually removed by someone in this view.

To place removed press plates back onto the layout, simply drag and drop their thumbnail onto the

layout.
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+ Usethe search field to reduce the list or to find a specific press plate.

At the bottom of this pane, next to the filter, the button Load More request the plate merger to load
more press plates in this list (press plates that are part of the current merge queue).

The resulting extra press plates in the list are then also available to be manually placed on this
layout.

Note: Extra press plates are only considered when they also have these attributes in
common:

» Resolution

« Imaging technology

« Cutting flow.

Although press plates that are on hold are not part of any layout proposals, the Load More function
will also load matching press plates that are on hold. The preview of such a press plate will show the
'hold' icon and offer a tool tip at the bottom left.

When you drag & drop any of these onto the layout proposal, their status (icon) will change
automatically.

And when you remove them from the proposal (move them back to the list), they will automatically
get their 'on hold' status again.

Optimizations for Staggered Cut Press Plates

Concept

In a layout proposal, the space in between press plates with staggered cut lines is actually also wasted
material. In below example, this is the vertical space between the 2 columns:

b ¥ ¥

b W L s

NI aD ad A
- ;.,E-.,-' - 20

A user can select and manually move press plates into each other, reducing waste and possibly even
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Manual move

You can select and move press plates in a wanted direction. In below example we moved the 3 on the
right closer to the ones on the left.
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As soon as their bounding boxes overlap, you will still see a darker color which is the default way to
warn the user of an overlap. You can still go ahead and accept/expose such a layout proposal.

Ared color is a sign that this specific manual merge is not possible.
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Warning: No content should be placed outside the staggered cut lines. For example having
alabel on the press plates will block staggered cut press plates from being merged into each
other.

Load More

In case you now have extra space to load more press plates onto this layout, use the Load More button
(in the right pane at the bottom of the list of press plates).

2.6. Merged Plates

Concept

This view gives an overview of all Merged Plates that the Plate Merger created.
When your Pilot is in'Last Used Job' mode, you will only see the merged plates of that Job.

Merged Plates are kept in this database until they are removed by the cleanup settings that you define
in the Plate Merger item in the Configure tool.

Note: This view does not show merged plates that someone created manually in the DFS
merger using LEN files from a (local) "working folder". It does show merged plates that the DFS
merger made in "AE mode"(using press plates that were present in a Plate Merger queue).

Select a merged plate to see a preview and its key attributes in a right pane.

£l Automation Engine Pilot
File Edit View Go Job Tools Advanced Help
¢ > |@|® o |Containers v || -8 £
() Files (WDE G... | L3 Tickets £ Tasks (WOE ... EAPlate Merger ... | L.l Merged Plates ¥ Exposer Que... * Press Plates (... | ¥ Devices +

& General Created Date  Plate Type Total Area Total Used ... Waste Device Drum State Finishe... ~ Resolution Started Date
0 Files 3/8/16 115, DFH 1.14(045)  0.559m®  0396m?  0.164m* Spark 2535 V253SEC3 @ 3/8/1611.. 2,000 ppi 3/8/16 1155, —— ———-—— ——
BToDolist () yg/ig 11, DFHLI4(45)  0559m?  0347mt  0212m? Spark2535 V2SISEGS B B/I6 1. 2,000 ppl 3816 115 SN @ '@ @ @
& Products DFH 1.14 (045) 0.417m?  0.142m? Spark 2535 V2535€C3 @ DHMDeoee e
£ Tasks 3/8/163:1... DFH 1.14(045)  0.559m®  0.01m?  0.449m? Spark 2535 V25356C3 B 2,000 ppi —— ae——
() Smarthiames 3/8/163:1.. DFH 114(045)  0559m?  0.417m?  0.142m? Spark 2535 V2S35EC3 2,000 ppi 333008
3 Tickets 3/8/163:1... DFH 1.14(045)  0559m®  0.417m?  0.142m® Spark 2535  VIS3SEC3 @ 2,000 ppi P08

& a;& Display 3f8/1612:.. DFH1.70(067)  0559m®  048m?  0.079m? Spark 2535 V2S3SEC3 B 2,540 ppl —_—— T —
" s Plte 5ets 3/816 12:... DFH 1.14 (045) 0559m?  0.396m?  0.164m? Spark 2535 V2535EC3 ® 2,000 ppi s
P Press. Plates Plate Type: DFH 1.14 (045)
BBl Plate Merger Drum: V25356C3
i Merged Plates Resolution: 2000 ppi
" Device Queues Waste: 25%

= Cutting Tables
S Sheets Contains: 4 plates
JE Table Queues Plates: 32386_yog_des_passion_Clen

+ Setup 32386_yog_des_passion_M.len

32386_yoq_des_passion_Y len
32386_yog_des_passion_K.len
1 of § selected Server: ROVMAEL7 User: wde 219

In the preview, the pink area represents the non-used area(waste).

54




esko

Automation Engine

{ = ] Note: Test Strips are also shown in the preview and are also counted as waste:

Columns

{ = ] Note: Asin many views in the Pilot, you can

« re-arrange columns by dragging their title to a new position
» sort them by clicking on a column title

« right-click a column title and choose to Hide this one or any other. In the list that appears,
select Select Columns... if you want to change or re-arrange multiple items.

- use filters and optionally save them as a Smart View.

- define your preferred unit in Edit > Preferences > Units.

Most columns are identical to those already mentioned in the Press Plates View. We here only describe
those specific for this view:

Height and Width of the Drum.

Total Area: Height x width, the maximum area that can be imaged (drum surface.)

Total Used Area: Imaged area (the area occupied by press plates on the merged plate).
Waste: Total non used area of the merged plate.

Name: The grapholas parameter file (.par), containing detailed exposing parameters.
Estimated: The estimated Exposing Time. For example 12 : 27 means 12 minutes 27 seconds.

Attention: CDIs with a Grapholas version 12 up to v14.0 offer a more limited interface with
Automation Engine. The estimated expose time is then not accurate ; it will often be too
short.

Creator: 'MQ' indicates this plate was created by a merge queue (Automation Engine). The name of
that merge is mentioned in Merge Queue Name.

Merged By: It describes which technology was used to merge this plate. It can also indicate who
manually intervened.
« "AutoMergerProposal’ indicates it was done by the automatic algorithm of the Plate Merger.
« "Manual’ indicates that someone manually intervened in the layout. The network IP number
indicates on which computer this was done. The user name is also mentioned.
« "_DFSMerger" indicates that the layout was decided in the application "DFS Merger".
» "_Pilot" indicates that the layout was manually changed in the Pilot before choosing 'Expose’.
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% Solvent Saved and Solvent Saved Area: These show the % or square m2 of solvent that was
saved on that merged plate. Learn more in Working with Solvent Saver on page 89.

Functionality

After selecting an entry, right-click or choose the icon in the tool bar to:

Reconsider:

This resubmits all the press plates of this entry back to the plate merger and it removes the entry
from this device queue. It also removes the entry for that merged plate in the Merged Plates view.

This feature is interesting when you think that you can get a better fill percentage on this merged
plate when some of the new (smaller) press plates that recently arrived in the merge queue could
also become part of the layout.

»::/ Resubmit Merged Plate: This resubmits the merged plate back to the CTP device. A dialog
opens where you can choose the device. By default it proposes the one that was used before. When
you confirm this choice, you will immediately see it appear as a new entry in the Device Queues view,
at the end of the queue of the chosen device queue. When the chosen device is not compatible for
this job (due to different imaging technology for example), you will get a warning and you will not be
able to resubmit.

Most typical use cases:

« when a flexo plate was damaged and you need to remake the whole plate again, in exactly the
same way.

« when the flexo plate (that you do not need to cut)is used for a very long print run and a press
operator asks you to create an extra exact copy of that flexo plate.

/A Attention: This does require that the LEN (or TIFF)file of the merged plate has not been
cleaned up yet (see setting in the Plate Merger Configuration).

Note: Resubmitting a merged plate also creates, for each press plate on that merged plate,
anew entry in the Press Plates view. It also affects the numbers in the Press Plate Sets view,
in its columns Merged Plates and Press Plates.

»[ Resubmit Press Plates: This resubmits all the press plates on this merged plate to the plate
merger (those same LEN files with their same submit options).

The difference with the above "Resubmit Merged Plate" is that the press plates may this time end up
on a different kind of layout, on a merged plate that looks different.

/' Attention: Note that, if the selected merged plate is still in the CDI "Exposer” queue, that
this does not remove it from that queue. Also for TIFF devices, this does not remove any
TIFF files from the output folder. If you do wish to also remove the itemin the CDI "Exposer"
queue, then we advise to use the feature 'Reconsider Merged Plates' that is available on
items in Device Queues.

Show in Device Queues: This opens the Device Queues View with this merged plate selected.

Note: When you delete the queue entry there, its merged plate will still be part of the
Merged Plates view but its state will be on Done, with errors.

Open Preview: This shows the merged plate as it would look in the DFS Merger.
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© ROVMAEL7_20160503-102229_3_cdipar [

200

1. Theredareaindicates the merged plate margins, as set in the Plate Merger Configuration.

2. Thelight grey indicates the press plate margins, as set in Merge Settings of the used Merge
Queue.

3. The green objects indicate cut marks or lines, as set in Merge Settings of the used Merge Queue.

Note: This type of preview also shows a preview of any placed test strips.

« OpeninBrowser. This tool is not required in normal daily use, but can be helpful to easily access the
files created in background (in the folder as defined in the Configure tool), for example to read the
XML file.

Zooming in on a Merged Plate

Double click an entry to get a closer view of the content of that merged plate.
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plates.

view, use the toolbar button instead: > =

Tip: You might have landed on this view directly from another view (for example by using the
"Go to Merged Plate" option in the Press Plates view). If you then want to go back to that previous

When you select a press plate, its key info is added to the right pane.

You can use CTRL-click to select multiple press plates and see their names highlighted in the panel.

Functionality:

After selecting one or multiple press plates, a right-click offers to:
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Resubmit Press Plates: Also here you can resubmit the selected press plates back to the plate
merger, where they will start their workflow again from that point on. The way they are submitted
is identical as when they were originally submitted to the plate merger (same plate type, imaging
technology, grouping keys, etc.).

Attention: This does not remove them from this merged plate and this does not remove
the merged plate. This function is therefore useful when the merged plate was already
imaged and you later want to image only some of the press plates again.

Go to Job: When the Pilot is in Container mode and when the selected press plate is part of a Job,
select this option to filter the Merged Plates view to only those of that Job.

Go to File: Open the Files view and selects the LEN file of the selected press plate.
Show in Press Plates: Shows the selected press plate in the Press Plates view.

View. Opens the press plate's LEN file in the Automation Engine Viewer. This will require the LEN
file to have prepared view data(learn more in Working with RIP data in the AE Viewer).
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Note: If you wish to open LEN files in the DFS "View" application (aka "Esko Bitmap Viewer",
Windows only), then choose 'Go to File' and double-click the file there. This will open the file

in the application that you first instructed your local computer to 'open with'.

« New Task: Use this tool to select a task ticket to launch on the LEN file of the selected press plate.
This is for example how you can submit the selected press plate(s) back to the plate merger but use
different options than those that were used originally.

2.7. Device Queues

The Device Queues view shows the queues of configured Flexo devices, both the CDIand the TIFF

devices.

« The queue of CDI device shows what is present in the "Exposer" queue of that CDI. The "Exposer”
is the DFS/Grapholas application where you manage the queue and start the actual exposing. This
view automatically updates to show new or changed entries.

« The queue of a TIFF device shows the TIFF files that are currently in its Output Folder.

You can see these queues inatimeline orin alist view mode.

© Automation Engine Pilot

File Edit View Go Job Tools Advanced Help
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Note: Go to Tools > Flexo Device Queues to open this view in a separate window. To avoid
seeing only Job specific entries, switch to Container view or Jobs Overview before doing this.

Note: When a CDI device is offline, this icon appears next to its name: @
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Note: Before v21.11, the view 'Device Queues' was named 'CTP Queues', and its category 'Flexo
was named 'Flexo CTP'.

%3 Time Line View Mode
« Each queue entry is visualized by a rectangle. Its default color is blue.

For a CDI device, it's length corresponds with the estimated duration to expose that job.

/' Attention: CDIs with a Grapholas version 12 up to 14.0 offer a more limited interface
with Automation Engine. The estimated expose time is then not accurate ; it will often
be too short.

Entries in a queue of an(offline) TIFF device are always shown by a rectangle representing 30
minutes. The time in between entries, representing a plate change, is a default of 3 minutes.

« Whenan entryis being exposed, that entry moves gradually to the left of the red line. Fora TIFF
device, the entries appear and disappear as the TIFF files appear of disappear from their output
folder.

Use the slider | to increase or decrease the size of the queue entries.

Tip: Click on the slider to select it. This is indicated by the blue bar: -
this point you can use the arrow keys to increase or decrease the entries.

« Selectanentry to see its details on the right. You can use the left-right arrows to navigate
through the queue and change the selection. For TIFF files, only the resolution and size is
known.

»  Whenyour Pilot is in Last used Job mode, all the entries that relate to a different Job are greyed
out and can not be selected. Switch to Containers view to make sure you can select any entry.

List View Mode.

This view makes it easier to read an entry's name or plate type. You can also click the column
headers to sort by that attribute.

Note: When your Pilot is in Last used Job mode, this list only shows entries that belong to
the selected Job.

Conditional Coloring

Coloring the entries helps to get a quicker understanding of the queue's content. You could for example
assign a color per plate type or per resolution or per urgency (based on due date).

This conditional coloring is applied on all devices and is saved per user, so different users can use
different coloring rules.

Follow these steps:

« Right-click the name of any of the flexo devices and choose Conditional Coloring.
» Addone or more rules.

« Rules are executed top to bottom. Use Move Up / Down to change their order.
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Managing Queue Entries

Search and selecting. Type in the filter field to search on(parts of) a job name or plate type
properties. For example, search on the name of plate type or a resolution.

Tip: Selections that you make remain active when you switch the © / = view modes. An
example: In the = List view mode, sort per column and then make a multiple selection.

Then switch to the = Time Line view mode where the selection is kept and then move the
selected entries to the front of the queue.

Tip: You can also execute below mentioned actions on selections that you made with the
filter.

Deleting queue entries. Select and press Delete (or right-click and choose Delete) to remove
entries from a queue. You will be asked to confirm.

Deleting a queue entry from a TIFF device deletes the TIFF file.

In the Merged Plates view, you can see how the merged plate still exists but has changed its status

to E'Cancelled'. The related press plates and press plate sets also get the status 'Cancelled'.

Moving an entry to a different position in the queue. You can re-arrange entries in a queue by using

drag and drop, even on multiple selected entries.

This functionality is not available for TIFF devices.

Moving an entry to another queue. When a CDI needs to go in maintenance, or when you manually

want to balance the load, you can drag and drop one or multiple queue entries into the queue of
another CDI device.

Because a device is never exactly the same, the merged plate that changes device will always be re-

calculated. You will always get feedback and will be asked to confirm.

« The system does various checks if the new device is compatible for this job. When the entry
cannot be exposed on the other CDI, you get a warning and the entry will stay in its original
queue.

«  When the entry can be exposed on the other CDI, you get an information dialog and the entry will

eventually show up at the back of that other queue (so not in the place where you dropped it).

Note: This is what happens in detail: All device specific data is removed from the layout

XML file and the output workflow of the merge queue (where it was originally made) is
launched again. This re-creates a merged plate and that LEN file is then submitted to
the new device where it appears as a new entry at the back of its queue.

This functionality is not available for TIFF devices.

Reconsider Merged Plates.

This resubmits all the press plates of this entry back to the plate merger and it removes the entry
from this device queue. It also removes the entry for that merged plate in the Merged Plates view.

This feature is interesting when you think that you can get a better fill percentage on this merged
plate when some of the new (smaller) press plates that recently arrived in the merge queue could
also become part of the layout.
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3. Flexo Device related Tasks

. Note: Inastandalone setup of Device Manager, several of these tasks are not available.
]

3.1. Add Margins to LEN file task

Note: The flexo CTP platemaking workflow, its terminology and the Plate Merger are described

' in the introduction of this chapter.

Concept

This task adds margins to a LEN or LENX digital film file. These extra margins can so help plate
mounting or plate re-mounting (PlatePatcher workflow).

Using this task can also make sure that there is(just) enough space between press plates (LEN files)
on a merged plate. However, that can also be achieved by using the option Press Plate Margins in the
merge settings of a Merge Queue. That way, you are not changing the actual press plate LEN files but
only adding these extra margins in the calculation of the layout.

| | Note: When you want to add extra margins to a merged plate, then use the plate merger's
option to add margins to the merged plate.

| | Note: This task fails when the input file is a LENX file that contains Plate ID metadata. The
Plate ID needs to be applied first before using this task.

Settings

Enter a value per side or use SmartNames to specify the value(s). SmartNames can help automate the
fact that your different printers may want different plate margins.

{ . Note: You can also enter negative values. That side will then be cropped with that distance.
]

You can however crop the file automatically with the Crop LEN File task.

1 Attention: Some Step & Repeat tasks (and also Plato) offer an option to "Include CAD info for
Digital Flexo Suite" in the PDFPLA file. This is used to include the technical inks data in the
metadata of the output file. In the Bitmap Viewer and in the DFS Viewer, you can see these as
layers “Plato Cut”and or “Cut/Crease line registration”. A LEN file made from that PDFPLA file
will then have that information embedded. However, launching this Add Margins to LEN file
task or the Crop LEN file task on such a LEN file will remove that metadata (layers)and end
with a warning. Mind that this does not remove the metadata / layer named “Staggered Cut".
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Note: If you want to view your LEN(X) files after adding margins (for quality control), you can
use:

« the Grapholas Viewer,
» the Bitmap Viewer,
« the Automation Engine Viewer, once their view data were ‘prepared, either by

« earlier, in the RIP task, using the Output option 'Make all output files ready for viewing'.
« orafter RIPiing, using the 'Prepare for Viewer' task.

3.2. Apply Plate ID to LENX file

Concept

This task resolves the metadata that describes the Plate ID into the LENX file's pixels. To do that, it
uses a pattern that is fit for the selected type of flexo plate.

Learn more about Plate ID in Working with Plate ID on page 82.

Task Settings
« Plate Type: Select the type of plate that this LENX file is intended for.

The list shows all plates that are available on the configured CDI device(s)and that are Plate ID
enabled.

General behavior

« Thetask supports multiple input files.
« Thistask will fail in these cases:

« Theinputfileisnota LENXfile.
« Theinput file contains no Plate ID data in its Plate ID metadata tag.
« Theinput file already contains a patterned Plate ID.

- APlate Type was selected that doesn't exist (any more) or that doesn't contain the appropriate
Plate ID specification.

3.3. Create Flexo Plate Cutting Paths

Concept

The feature of creating Flexo Plate Cutting Paths is an alternative to Staggered Cutting in ArtPro or
PackEdge/Plato.

It is designed to facilitate seamless printing in non-sleeve workflows. This means that when web fed
flexo printing jobs are not using flexo sleeves the flexo material is cut and wrapped around a cylinder.
The unavoidable seam will be positioned in between printable objects.
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Flexo Plate Cutting Paths is the tool to define the shape of the flexo plates, which will later in the
process be sent to a Kongsberg table on which the flexo plates are cut.

A cut path can be used for all separations, or a cut path per separation can be defined.

Note: Flexo Plate Cutting Paths can only be created on PDF+ files. If necessary, convert
Normalized PDF files to PDF+ first.

Tip: When, in alist, you choose 'Select SmartName...", right-click a parameter and select '‘Copy
Parameter Value' to find out what the SmartName should resolve to. Paste that value anywhere
to see the correct possible value.

Task Settings

The task's settings are the same as documented in the user guide of ArtPro+, in Prepress functions >
Step & Repeat > Flexo Tools > Create Plate Cutting Paths.
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Web Direction: Horizontal or Vertical. The plate orientation versus the printing direction.
Plate Width: Select the page box that defines the plate width.

Plate Circumference: Type a Custom value or have the circumference defined From Grid or Page
Box.

Cutting Paths Strategy:

- Optimize plate usage: Select this to generate cutting paths that make the best use of the flexo
plates.

« Prefer stagger pattern: Select this to generate cutting paths that follow the stagger pattern of
the grid as closely as possible.

Note: This task can detect stagger patterns from Step & Repeats generated in ArtPro+ or
other Esko applications. If no stagger pattern is found, the Optimize Plate Usage method is
used.

Keep Away From Imaged Areas: Define the distance that a cutting path should keep away from an
imaged (printing) area in the file. See the default ticket to see the default values.

« Minimum Distance
- Preferred Distance

Corner Radius: Rounded corners facilitate cutting and avoid damaging the plate when taking it off
the cylinder.

« Minimum Radius
« Preferred Radius

Gap at Seam: You might want to make the flexo plate a bit smaller than the repeat length (= plate
circumference). The distance between the two identical segments will be 'Repeat Length'
minus 'Gap'.The gap is divided equally over top and bottom.

« Minimum Gap
+ Preferred Gap
Clip Bleed At:

Use this option to specify bleed outside the plate cutting paths, so you can compensate for mis-
registration issues during plate cutting on the cutting table.
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« When a positive value is entered for the bleed, the artwork will extend beyond the plate cutting
path according to the above chosen Web Direction: top and bottom for the vertical direction, or
left and right for horizontal.

+ When the negative value is entered, the artwork will cut away from the plate cutting path.

A Warning: In this version of Automation Engine, the Plate Merger view/editor does not yet
automatically detect this bleed on the plate cutting path, whether you set bleed using this
task or interactively in ArtPro+. Learn more about this limitation in the dedicated page
below.

« Use the same path for all separations: When not selected, the task creates a separate path for
each separation.

When selected, the task will end in error if a single path could not be generated for all separations.

3.3.1. Bleed View limitation

As mentioned above, in this version of Automation Engine, the Plate Merger viewer/editor does not
yet automatically detect this bleed on the plate cutting path, whether you set bleed using this task or
interactively in ArtPro+.

We will use an example to illustrate this:

« The Plate Merger shows a layout proposal with 2 press plates. They each show a bleed outside their
plate cutting path.
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«  When you manually move press plates towards each other (typically to do a manual nesting), the
view will, as soon as press plates start to overlap, switch to showing the cut line (and no longer the
bleed).
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22

« At this point the view also allows you to snap them side by side. But you no longer see the bleed,
which is still there and even causing an overlap. When deciding to output this manually created
layout, you will be shown a warning that press plates are overlapping.
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This layout contains overlapping press plates. Are you sure you want
to expose this layout?

| Expose anyway | | Cancel |

When you then choose to expose anyway, your plate will contain unwanted overlaps by the bleed.
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3.4. Crop LEN File task

Note: The flexo CTP platemaking workflow, its terminology and the Plate Merger are described
=== in the introduction of this chapter.

Concept

This task serves to crop a LEN (or LENX) digital film file to the bounding box of all visible objects
combined. By default, the task crops the LEN file to first pixel of that separation.

However, when there is a staggered cut line present in the file, the task crops to the bounding box of
that line (even if there are pixels outside the cut line). An example:
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PLATO (PDFPLA)

viewing cyan separation LEN file LEN file
and the staggered cutline

cropped to the
staggered cutline

TTF =

Note: A typical workflow might be to first use this task to crop the LEN files and then use the
Add Margins to LEN file task to add margins again (and maybe not on all 4 sides).

Note: This task fails when the input file is a LENX file that contains Plate ID metadata. The
Plate ID needs to be applied first before using this task.

Attention: Some Step & Repeat tasks(and also Plato) offer an option to "Include CAD info for
Digital Flexo Suite" in the PDFPLA file. This is used to include the technical inks data in the
metadata of the output file. In the Bitmap Viewer and in the DFS Viewer, you can see these as
layers “Plato Cut”and or “Cut/Crease line registration”. A LEN file made from that PDFPLA file
will then have that information embedded. However, launching this Add Margins to LEN file
task or the Crop LEN file task on such a LEN file will remove that metadata (layers)and end
with a warning. Mind that this does not remove the metadata / layer named “Staggered Cut".

Note: If you want to view your LEN(X) files after cropping (for quality control), you can use:

« the Grapholas Viewer,
- the Bitmap Viewer,
« the Automation Engine Viewer, once their view data were ‘prepared, either by

« earlier, in the RIP task, using the Output option 'Make all output files ready for viewing'.
- orafter RIPing, using the 'Prepare for Viewer" task.

Task Settings

Bleed:

« The bounding box of all pixels found in a separation is extended with this bleed. The task then crops
to that enlarged area.
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« |Ifthereis a staggered cut line, the task crops to the area of the bounding box of the cut line,

enlarged with this bleed.

3.5. Submit to Plate Merger task

Note: The flexo CTP platemaking workflow, its terminology and the Plate Merger are described

in the introduction of this chapter.

Concept

This task serves to submit Press Plates (LEN files) to a Merge Queue of the Plate Merger.

Press plates that you submit to a merge queue can be merged together on a same merged plate,

« when they have the same value for plate type, resolution, imaging technology and cutting workflow,
- and when they have the same value for custom Grouping Keys (that you can set up in the Configure

tool).

i g I Attention: The plate merger requires that the XMP metadata of the input LEN files contain
information on hsize, vsize and resolution. Thisis the case for LEN files created by

Imaging Engine or FlexRip version 14 or higher.

Important: LENX files are LEN files that contain Crystal screens. The plate merger will error
4200.  when he is asked to make a layout for a TIFF device, which does not have the required 'Crystal'

technology.

In a workflow, you can add this task after the RIP'ing task. See this example, where the LEN files are
first cropped and where also view files are created for the Automation Engine Viewer:

Red Wine Front 2011_pdfpla Red Wine Front 2011_201_c275_crop.len
Red Wine Front 2011_Varnish_c275_crop.len

\

Start LEN - 2000 ppi Crap LEN File

Red Wine Front 2011_201_c275.len
Red Wine Front 2011_Varnish_c275.len

Tab 'General'

spark 5080 - OK
bevel cut

@
CE

Prepare for
\iewer

« Merge Queue: Select or name one of the merge queues that you defined in the Plate Merger view.

Note: When a £ warning sign a appears left of the selected name, hover your cursor over

the icon to read more about the problem.

« Rotation: Define how the press plate may be rotated on the merged plate:
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« Set by Merge Queue: This leaves the decision to the merge queue, so allowing it more variants in
its calculation of the layout with the best fill percentage.

« Force 0: It will not be rotated, it will stay in the orientation as shown in the press plate preview
and as shown in the Automation Engine Viewer.

« Force 90: It will be rotated 90 degrees clockwise.

« Select SmartName: To find out what the parameter value is of an entry in a drop-down list (or of
anicon), select that entry from the list, then right-click that setting and choose Copy Parameter
Value. Then paste that value in any input field. You then can see what the SmartName should
resolve to.

Note: Arotation(request)on the merged plate is never done on the input press plate LEN
file(s). On that level, it is only done when the merged plate LEN (or TIFF)file is created
(during the Create Merged Plate task).

Imaging Technology: Select the imaging technology that these press plates need to be imaged
with. This field automatically serves as a grouping key.

This list shows all available technologies on all configured Devices (DFS Merger's). It is automatically
updated. Learn more about these technologies in the documentation of PlatePrep.

For any output on a flexo CTP TIFF device, you need to select 'Standard'. Else, they will appear in
the plate merger but will be rejected immediately resulting in an error status. The details pane will
explain that the selected technology is not available on that device.

Note: The technologies 'Speed' and 'Speed UV' require Grapholas v19.

Note: The technologies 'Speed XPS' and 'Standard XPS' require Grapholas 20.1.8 or higher

Due Date: When considering the layout of a merged plate, the merger's main criterion is the fill
percentage (learn more in Plate Merger on page 23). However, when you here add a due date, the
merger also takes this time into account to make sure you that you have these press plates on the
CTP device on time (there as part of a merged plate).

Note: The effect of setting a due date can be compared to the Force Out option in the
merge queue, but then as an automatic step at the specified time.

« None.

« Time setting: Select or specify an absolute or relative time.

« Job due date: The due date is taken form the due date of the Automation Engine Job that the
LEN files belong to(residing in its job folder).

Note: When the job due date changes, the entries in the merge queue that were
submitted with the list option"Job due date" will adapt and reflect this new date.
This will only be done if the press plates are still in the Merge Queues. This will not be
done if the press plates were already sent to the device queues.

Note: When the due date you want is the one from the Job, then do not use the
SmartName version ; use this item in the drop down list to avoid any error due to
formatting problems.
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« Select SmartName.

Note: If you are using a SmartName for date or time, the resulting format needs
to be compliant with ISO 8601(YYYY-MM-DDThh:mm:ssTZD). For example:
2014-07-28T12:00:00+01:00.

/b Attention: When you relaunch a Submit to Plate Merger task that had a due date defined
on an absolute time, it is then possible that that due date has already passed. This will have
the effect that the press plates, the moment they arrive the merge queue, already have the
status 'forced out', and therefore quickly disappear again from that queue.

Label: The text you enter here is placed on the merged plate, around each press plate. The text label
is placed on the left of the below chosen position, . It uses the font "Arial" and the size is 4 mm. If
there was not yet a margin of 4 mm, it will be created automatically on the side where the label is
placed.

« Position: If you defined a text label, then choose here in which margin around the press plate
that the label should be positioned. Top or Left means on top of or to the left of the press
plate as you would see it when viewing it placed on a merged plate and viewed using the "Show
preview". When using a SmartName, use t for Top and 1 for Left.

Note: Alabel will not be rotated, even if the corresponding press plates got rotated
on the layout by the plate merger or manually in the proposals view. When you are
eventually holding the physical flexo plate that got produced (in the correct way), then
you should be able to find the label for each press plate in a similar place (regardless of
any press plate rotation to get to a better layout).

Note: If either the label text or position is based on SmartNames that cannot be
resolved for one input file, the task will fail for all input files.

Note: Before AE v18.1.1, adding a label added a margin of 4 mm on all 4 sides of the press
plate.

Allow different devices and rotations:

« When this option is not selected, all press plates that you here submit will end up on the same
device and have the same rotation.

« When this option is selected, they can end up on different devices and have different rotations.
This can result in layouts with less waste.

Apply cutting flow:

Select this option when the merged plate will be cut on a Kongsberg cutting table.

« When that Kongsberg table was also added as a Device, then the workflow status will include the
status of the cutting on that table. The status 'Exposing Done' will change to (Cut) Done' once
that signal comes back from the Kongsberg table.

+ When that Kongsberg table was not added as a device, the required cutting files will still be
created but you have to adapt your workflow so that they are provided to the table. Learn more
below on setting up this cutting workflow in the Configure tool (Plate Merger).

This off-line link means that the flexo device workflow can not be aware of the cutting status. It
therefore already sets the state of the (merged) Plate to 'Cut = Done' right after the exposing is
done on the flexo device.

73



esko

Automation Engine

{ ' Note: This option is not available when your setup is a standalone Device Manager. Contact
' Esko to learn how to extend this functionality.

« Cutting Flow. Select the type of cutting from the drop down list. This field automatically serves
as a grouping key.

{ ' Note: The .xwf files in this list are those on the central resource folder on the
' Automation Engine server. This is the folder where the DFS merger writes .xwf files
when it isin"AE" mode.

The Cutting Flow that you define here will later be part of the XML file that, once the CDI plate
is made, can automatically be sent to the cutting table. Learn more in the Configure tool, where
to define that workflow to launch (in the tab Setup) and where to define any reporting related to
cutting(in the tab Reporting).

Tip: To achieve a better fill rate, the Plate Merger by default merges press plates with and
without a cutting flow. However, the plate merger will not merge press plates that ask for a
different cutting flow.

In the special case that you never want to mix press plates with and without a cutting flow,
you can use a grouping key to prevent this:

1. InPilot> Configure > Plate Merger > (Setup), pick a custom field, give it the name (for
example "Manual Cutting')and select the option"Use as grouping key".

2. Then, when submitting press plates that may not be cut on a cutting table, put the value
for this custom field ("Manual Cutting")on"Yes".

« Job Info: This option is only available when your setup is a standalone Device Manager. Consider

using SmartNames to pick up job information that came from your MIS.

Tab '‘Custom Fields'

« CustomField1to5: The name of these b custom fields is set up in the Configure tool. Their name

becomes the name of the columns in several of the CDl related Views. You can then also use their
values when filtering. A setting in the Configure tool decides whether they will also be used as
grouping keys.

3.6. Create Merged Plate task
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{ ' Note: The flexo CTP platemaking workflow, its terminology and the Plate Merger are described
" in the introduction of this chapter.

Concept
As mentioned in Main steps in setting up a Flexo CTP workflow and in the Plate Merger View, this task is
the first step of the workflow that the merge queue launches when having created a layout.
The input file of this task is the XML file with all the details of that layout.

The task creates a LEN file of that layout. When the chosen device is a flexo TIFF device, this layout file
isa TIFF file.
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It also creates previews and other files that are all written in the Output Folder defined in the Configure
tool(where you can also define when these files need to be cleaned up).

{ = Note: Creating a large bitmap file is an intensive task for your Automation Engine server. You
will also notice that this task takes longer when it first needs to rotate press plates before
placing them on the layout.

By default, the Name is the name of the input XML file. Use SmartNames to change this. This name will
be used as the name for the job in the CDI's Exposer queue.

The output of this task is also an XML file. This one refers to the LEN file and other related files it
created.

When this was requested for its press plates in their Submit to Plate Merger task, this task also creates
the cutting instruction. This cutting file is also referred to in this task's output XML file. Learn more
about how and when this cutting information gets to the cutting table here.

Settings

« Name. Once the output file is submitted to the device,

« whentoaCDl, thisis the name of the entry in the CDI's "Exposer” queue. By default, the
SmartName [File] will make the CDI job name equal to the name of the XML layout file that the
merger created: <name of AE server> <date>-<time> <sequal number> cdi.

« whensubmitted to a TIFF device, this is the name of the TIFF file written on the queue's output
folder.

3.7. Submit to Flexo Device task

i = Note: Until AE v18.1.1, this task was named 'Submit to CDI'. Tickets that were made in those
older versions will still name this task like that. And until v21.11 it was named 'Submit to Flexo
CTP task'.

i =l Note: The flexo CTP platemaking workflow, its terminology and the Plate Merger are described

in the introduction of this chapter.

Concept

This task submits a merged plate to a Flexo Device Queue. The input file for this task is not the actual
LEN or TIFF file of the layout. The task's input file needs to be the output XML that was created by the
Create Merged Plate task.

As mentioned in Main steps in setting up a flexo CTP workflow and in the Plate Merger View, this task is
the last step in the workflow that a merge queue launches once it decided on a layout.

i = Note: This task type can not be re-launched. To resubmit a merged plate to the CTP queue for
which it is intended, use the function Resubmit Merged Plate in the Merged Plates view.

In the Pilot, the task's Details pane offers a link to an XML report file. Learn more about what you can do
with these report files in Reporting to Business Systems on page 11.
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4. Using the DFS Merger in AE mode

Concept

This page illustrates the semi-automatic workflow that we introduced in the introduction of this
chapter.

Configuration

To make the DFS 'Merger' application see the merge queues on Automation Engine, the AE server
needs to be configured as "Workflow Server".

Note: The communication between a DFS Merger and Automation Engine happens via JDF/
et JMF.

Follow these steps to link a DFS Merger to an Automation Engine server:

1. Inthe DFS Merger, add the name of your Automation Engine server in Options > Preferences >
Merge tab > Workflow Server.

2. Click OK.

3. Test the connection by loading some images from a merge queue (see below).

Workflow Steps

1. Click the "8 button. The title bar indicates you are now working in "AE Manual" mode. A green
background color also reminds you of this different mode.

-
E Merger File Mode E Merger AE Manual Mode ‘
File Start Position Windows Edit File Start Position Windows Edit Options Help

el e H HE DES e B @ = i O
- " g8 &

Note: To change the mode back to (local)"File Mode", simply click [*El again.

Note: This button does not appear when there was a problem connecting to Automation
2= Engine when starting up the DFS Merger.

2. Click ™ to load images. A dialog opens that shows the AE merge queue(s)and their contents:

76



esko

Automation Engine

E Select an image set i _ 1 u

Queue Image sets Images

Hame Resolufion Techology HL-Cut Imag MName

Full-HD ML Cut 'Red 'Mneant 2011 201

DFH 1.14 (045) for CDI Spark 2530

| ;

OFH 1.14 (045) for CDI Spark 5080
Red Wine Front 2012_Varnish

= = | |Red Wine Front 2013_Varnish
| |RedWine Front 2011_Varnish

Red Wine Front 2012_201

Load Selecled Image Set Filter @

Note: Locked items are shown in pink (for example images that you already loaded or
“=" image sets being used in another DFS Merger).

« Queue: This dialog only shows the merge queues that contain images (press plates).

Note: Press plates that in their merge queue have the status ¥ "Rejected" are not shown
== inthis dialog.

« Image sets: Sets are groups of images that can be exposed together on the same plate, typically
because they have all their grouping keys in common. The columns already show some attributes
they have in common.

Note: Test strips are not shown in this dialog. They do appear as a Loaded Image after
&= you clicked Load Selected Image Set. Learn more below.

- Images: Shows which images are in the selected image set.

* Filter: When you type a(part of an)image name in this field and click < you will only see the
image sets (middle pane) or merge queues (left pane) that contain images with that (part of

their) name. To remove the filter, empty the input field and click < again.

» Load Selected Image Set: Click this button to add all images of the selected image set to the list
of Loaded Images in the DFS Merger.

The attributes that these images share (as shown in the columns in Image sets) are enforced
into the DFS Merger. Also the margins and rotations that were requested on Automation Engine
are communicated to the DFS merger (the margins can here still be overruled).

Note: When your Automation Engine has a license for automatic merging by the merge

2= queues, clicking "Load Selected Image Set" also sends a signal to the selected merge
queue: To prevent any further automatic merging, this queue is paused. This way, that
merge queue only stays available for manual merging, until one of these actions is taken:

+ '"Load Selected Image Set" was clicked for an image set of another merge queue.

« The DFS Mergeris no longer in "AE Manual" mode.

« The DFS Merger is closed.
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{ = Note: When the image set contains a test strip (as requested in the merge queue's
configuration), it will also appear in the list of Loaded Images.

« To easily recognize it, its thumbnail will be marked with a letter "T".

|
I

TestStrip D

« You can manually place the test strip as any other image.

+  When using CTRL-A (Auto Arrange Images), the test strip will be placed bottom left
and no other images will be placed on top of it, against that left side of the plate.

Redine Front:

il
L

200

a 200

«  When using CTRL-H (Auto Arrange New Images), the merger will try to place the test
strip in the same place it was placed on the previous plate layout.

{ = ] Note: Click < to check if new images arrived in the image set that you loaded.

3. Now, in the same way as you would do with local images, create a layout with the loaded images.

{ = Note: When you have a partial plate that still has the full circumference (vertical size), you
can use that plate by first changing the plate's horizontal size.

4. Whenyou are finished creating the plate layout and ready to send this layout to the CDI "Exposer”
queue, click = Exeosel You will be asked to fill in a name of this job.

1 Attention: The value you here type in can appear as the job name in the CDI's "Exposer”
queue, but only if you also create a specific SmartName and use that SmartName in the
Create Merged Plate task. Learn more in Creating a SmartName for the Merged Plate output
File and Queue Entry on page 79.

In this "AE" mode, when you click # Exeose! (and confirm a name for the job),

« onAutomation Engine, the merge queue of the placed images starts its output workflow on this
manually created layout.

« Inthe DFS Merger, the used images disappear from the list of Loaded Images and also
disappear from the "Select an image set" dialog, because they were also removed from their
merge queue.
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5. On Automation Engine, the Tasks view shows the output workflow. When that workflow is finished,

the new job appears in the CDI's Device Queue that the layout was made for.

4.1. Creating a SmartName for the Merged Plate output File
and Queue Entry

As mentioned in the page describing the DFS Merger in "AE Manual"mode, the name that you type in

after clicking #¢ Exosel can be picked up by a SmartName so that it appears as the name of the job in
the CDI"Exposer" queue.

Follow these steps:

1. Create the SmartName as shown in this screenshot:

© CDI Jobname Typed in DFS Merger ‘ u

Type: |
Scope: :Global v:

XPath Expression:
fJobinformation/JOBNAME; text()

+[1Insert SmartName  Edit

Separator: 1
XML Source: |[URL of Input] 8]

Result: <<TNameConfigExample/>>

| Save As... || Formatting Options... | Cancel

Learn more about creating such SmartNames in XPath Query SmartNames.

2. Use this SmartName in the Create Merged Plate task that is part of the workflow launched by the
merge queue.

Settings for Step: Create Merged Plate

(&

a

Name: | [CDI Jobname Typed in DFS Merger]| 1

3. Test.
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Scope: _'Glahal

Note: When your CDI plate production is mixing the automatic merger workflow with this DFS
manual merger workflow, you can create and use this conditional SmartName:

If Any ~ of the following are true

CDI Jobname from XML - is~ |AE_AutoMergerJob 3]
CDI Jobname from XML + is empty =

Retum:|[F|Ie]

If none of the above match
Return: |[CDI Jobname Typed in DFS Merger]

1]

| Add Remove

Result: <<CDI%20Jobname%20Typed%20in%20DFS%20Merger/>>
Save As... H Formatting Options... ‘

This one checks whether the CDI job name is part of the (automatic merger's) XML file or if it
was typed in by a DFS user (if so, it uses the one we created above).
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5. FAQs

Can | send the information that | see in the Views to my MIS ?

Yes, workflows can send that information to your MIS. Also, your MIS itself can retrieve that info on
demand.

See the reporting options in Plate Merger Configuration on page 32.

What to do if a CDI plate is damaged after exposing?
It depends:

«  When you want to re-make the exact same flexo plate:

Go to the Merged Plates view, select the item and press *:: ("Resubmit Merged Plate"). Learn more
here.

+  When you only need to remake specific parts of that flexo plate (specific press plates):

Go to the Merged Plates view, double click the item to zoom in and see its press plates. Select the

wanted press plates, right-click and choose Resubmit Press Plates. Learn more here. Alternatively,

go to Press Plates view, select the press plates therg, right-click and choose Resubmit Press
Plates.

The resubmitted press plates are now back in the Merge Queue. Use "Force Out" if they are urgent.

«  When you want to re-expose all the press plates that were on the damaged merged plate, but it
does not have to be the same layout:

Then go to the Merged Plates view, select the merged plate, right-click and choose Resubmit Press

Plates.

The press plates are now back in the Merge Queue. Use "Force Out" if they are urgent.
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6. Working with Plate ID

6.1. Concept and Workflow Overview

82

Use Case

Due to their cost, flexo plates are often stored to be re-used later when that exact same plate is
required for a future print job. This could be a reprint of the same job or a re-use of that same plateina
similar job.

To find back that one specific plate (that separation of that (layout) job), a plate identification text is
added to the plate.

Some still write it manually onto the processed plate, some already add it digitally by using the 'label
feature in DFS or Automation Engine's plate merger. An example:

The disadvantage of adding the plate ID this way is that it consumes a(small) part of the available
area where you want to put the actual (merged) printing data. And that ID does not actually have to be
printed anyway. You are wasting a bit of (expensive) plate material.

Added to the plate - in the printing area - but not printing!

Data that is only imaged halfway the regular height for that type of plate will still be readable on the
processed plate but will not print on the substrate, simply because it is not capable of picking up ink.
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When we use this technique for Plate ID objects, we can even place it inside the printing area,
somewhere in an empty zone for that separation.

Looking at the plate at a certain angle helps to read the half-way imaged Plate ID. An example:

But how do you get that data to be imaged halfway?

How do you achieve something that you normally want to avoid? This time it is actually our goal to have
screening pixels creating dots that are too small to survive the processing of the plate.

This is done by applying, only to the Plate ID data, a pattern that makes sure the screened result is just
weak enough. i.e. that makes it visible but not printable.

The pattern to be used will be different per type of plate. So you will first have to do a test on each type
of plate you use. In your DFS, this will result in Plate configurations that are "Plate ID enabled".

Workflow overview

Main steps:

1.

In ArtPro+, open the (layout)job that you will RIP and add the Plate ID objects in an available empty
area. You can do this manually or by adding Dynamic Marks that also contain such objects. Learn
more in Adding Plate ID Objects in ArtPro+(Summary)on page 85.

Attention: Although ArtPro+ allows to use text, QR code, logo as Plate ID objects. However,
in this version, only text objects are supported (further)in the workflow.

As usual, RIP the job (CDI - LENX). Learn details about supported devices and screening in
Requirements on page 84.

Once you know on which flexo plate type you will produce the separations, use the special AE task
that applies the Plate ID metadata onto the RIP'ed data. This is where the special patternis used to
reduce the normal screening pixels. Learn more in Applying the Metadata into the LENX file on page
87.

Note: Any use of the tasks Crop Len File or Add Margins to LEN File needs to happen after
= this step.

As usual, either submit the RIP'ed files to the AE Plate Merger or make your merged plate manually
by using the DFS Merger application (in 'File' or in 'AE' mode).

As usual, expose the merged plate on the CDI, process it, cut it if needed, use it to print and when
done, store it for later re-use.

A schematic overview:
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Learn more details in the next pages.

6.2. Requirements

84

This workflow requires several Esko software products. Find a detailed description of these
requirements on the page of 'Flexo Engine' solution on www.esko.com/systemrequirements.

A summary
« Esko CDI Crystal XPS

« Only 2540 and 4000 ppi. Pixel Plus is not required.
« Only for U-fold and Z-fold optics

« Only for solvent-based plates

« Only plates up to 2,54mm.

« Eskoapplications:

« ArtPro+, v21.11 or higher

« Automation Engine with the 'Flexo Engine' bundle, v21.11 or higher
« Imaging Engine, v21.11 or higher

« Grapholas v19.10r higher / DFS - PlatePrep v20.1.4 or higher

« Other

« Pattern per plate type and resolution. Determined by means of a test form. Learn how in your
DFS documentation.


http://www.esko.com/systemrequirements
https://www.esko.com/en/support/product?id=Digital%20Flexo%20Suite
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6.3. Adding Plate ID Objects in ArtPro+(Summary)

Important: Plate ID uses the processing step technology and is therefore only available for
#2458 PDF+. The feature is disabled for Normalized PDF files.

Below is a summary. Learn more in the user guide of ArtPro+.

Objects you can use in a Plate ID
Not all object types can be used to create a Plate ID object.

« Not allowed: images, Placed Art, clipping paths.
« Notyetallowed in this version of the workflow: images, Placed Art, clipping paths.
« Allowed: in this version of the workflow, only text objects.

Static or Dynamic
You can add Plate ID objects as static or as dynamic objects.
- Static: You create and position the objects manually, select them and then choose Prepress > Flexo
Tools > Create Plate ID Object.
- Dynamic: You add Plate ID objects as (part of) a set of Dynamic Marks.

You can do this in ArtPro+ or by using the AE task Add Dynamic Marks or any of the Dynamic Step &
Repeat tasks. Mind that the task needs to be well aware where to position these objects.

Attributes of a Plate ID Object
« Paint:
a Plate ID Object is

« coloredin100% or 0% of the automatically created "Plate ID" processing step colorant (0% if the
original object was colored 0%; 100% in all other cases)

« settooverprint
« any transparency settings are reset to blend mode Normal, 100% opacity.

This also implies that gradients and patterns will turn into a 100% flat paint. As this may be obvious
for gradients but less so for patterns, a warning will appear about the loss of the pattern.

« Layer:

Plate ID Objects are moved to the "Plate ID" layer.
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Separations:

Use the 'Plate ID Object Browser' to decide on which plates the Plate ID Object will have to be
exposed.

By default, all artwork separations in use will be enabled. And processing step colorants and unused
artwork separations will not be enabled by default, but you can still (de)select any separation.
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6.4. Applying the Metadata into the LENX file

Note: Once you know on which flexo plate type you will produce the separation, you use the

task Apply Plate ID to LENX file to apply the Plate ID content and merge it with the print image.

This is done via the use of a pattern that is specific for the plate type and resolution.

Plate ID patterning

H H
Plate ID Pattern Plate ID
as metadata for chosen applied
in LENX plate type in LENX

To make sure this task uses the right pattern for that plate type and that resolution, it requires you to
select the plate type (one that was Plate ID enabled).

6.5. Specificsin the AE Plate Merger

When calculating proposal for a merged plate, the Plate Merger already restricted this to separations
that used a same plate type and had a same resolution.

Now, when the Plate merger considers a layout for LENX files, it will also only merge files that used a
same Plate ID pattern.

6.6. Setup in DFS and Testing

How to enable a Plate configuration for Plate ID?
This is described in the "User Guide: Plate ID" which is available on the documentation page of Digital
Flexo Suite: https://www.esko.com/en/support/product?id=Digital % 20Flexo % 20Suite .
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6.7. FAQs

88

Why does the RIP also propose to create a LENX file for the Plate ID objects
themselves?

Plate ID datais logged as a processing step and colorant. As always for processing steps, you can
RIP them if wanted. So in the RIP ticket, choosing All'in the tab 'Separations' will include this one
too. You can deselect this separation or just switch off the type in the tab 'Processing steps'.

In this case, when viewing the set of press plates in the Viewer, it is useful to have this one
separation where you can clearly see the Plate ID objects, for example just to know where they are
positioned.

We also assume you do not use them in output, so you do not submit these to the plate merger or to
the CDI.

Can | RIP a PDF with Plate ID objects to LEN or TIF?

The Plate ID workflow requires LENX files, but yes you can still select these unsupported file types.

In this version there is no warning or error when doing this.

Can | RIP a PDF with Plate ID objects with an unsupported resolution?

Yes, but a warning will mention that the Plate ID data will be removed.

Can | See the Plate ID in the Viewer?

Yes but only after it has been applied to the RIP data(so after the task '‘Apply Plate ID').

This is valid both for the Automation Engine Viewer and the Esko Bitmap Viewer.

Can | See the Plate ID in a Layout Proposal of the AE merger?

No. It is not shown in the preview data that is used in that Pilot view.

Can | Merge LENX files with Plate ID with LENX files without Plate ID?

Yes you can.

Can | Merge press plates that used a different Plate ID pattern?

The AE automatic merger will prevent this, i.e. not merge these onto a same CDI plate proposal.
In this version, the DFS manual merger does not check this and will show no error when you are
trying to do this.

| use Pixel Boost. Will that not make the Plate ID print?

No.
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7. Working with Solvent Saver

Concept

The system will add black areas in the waste area around the merged contents, so that when exposing
the plate the waste area also gets exposed to UV.

As a consequence the top layer of this waste area will not be washed away by solvent in the washer/
plate processor which leads to a reduction in solvent waste or solvent saving.

« Notusing Solvent Saver: the wasted area is shown in grey:

EEEEEEEEEEEERE S
EEEEETERER

« Using Solvent Saver: the wasted area is shown in black:
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Restriction: When combining solvent saver with a cutting flow (option in the Submit to Plate
Merger task) the legacy ACM file format is not supported, only the iPC format.

Workflow

1. AE Pilot: Flexo Merge queue: use the solvent saver in its Merge settings.
2. (Asusual)image the resulting merged plates on the CDI.
3. (Asusual)process the plates.
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8. XML technical details

This section adds technical information to help you interpret some of the XML files that appear in this

workflow.

8.1. Interpreting the Reporting XML files

Reporting XMLs were introduced on this page about the plate merger configuration.

Content wise, there are basically 3 types:

« an XML describing the merged plate that was queued to a flexo device.

« an XML describing the merged plate that was exposed on a flexo device.

« an XML describing, from a job order point of view, details about the current state of the press plates
of that job.

Their main content and structure is easy to understand. Below we only illustrate the terms that require
some explanation.

A

Attention: Be aware that the terminology in these XMLs uses the vocabulary of the DFS, i.e. a

press plate is referred to as an image and a merged plateasaplate.

The root element of these XMLs is <FlexoPlateReport>.

Terms used when describing the XML element <Plate>

The XML element P1ate refers to a merged plate that is processed on the CDI.

Below

described statuses are those at the moment the XML report was created.

« <ExposeState>: Possible values are:

MP:QUEUED: The merged plate resides in the "Exposer" queue of a CDI.
MP:EXPOSING: The merged plate is being exposed on the CDI.
MP:EXP: The merged plate has been successfully exposed on the CDI.

MP:EXP_CANCELED: The merged plate entry in the "Exposer” queue has been removed before
exposing.

MP:EXP_ERROR: The merged plate was not successfully exposed on the CDI or no information
could be obtained for the merged plate when consulting the DFS.

MP:RECONSIDERED: The merged plate has been reconsidered. It therefore no longer exists.

« <CuttingState>: Possible values are:

STC10:WAITING: The merged plate resides in the queue of an iPC (Kongsberg table).

STC30::DONE_OK: The merged plate has been successfully cut on a Kongsberg table.
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« STC50:DONE_ERROR: The merged plate was not successfully cut on a Kongsberg table.

Terms used when describing the XML element <Image>

The XML Element Image refers to a Press Plate.
« <State>: Possible values are:
« STI10:WAITING: The press plate is part of a merged plate that resides in the "Exposer" queue of a
CDlI.
« ST20:EXPOSING: The press plate is part of a merged plate that is being exposed on the CDI.

« ST30:EXP_OK: The press plate is part of a merged plate that has been successfully exposed on
a CDI.

« ST50:EXP_ERROR: The press plate is part of a merged plate that has not been successfully
exposed on a CDI.

« ST80:EXP_CANCELED: The press plate is part of a merged plate that has been removed from
the "Exposer" queue of a CDI.
« <Plateld>:

The 3rd type of XML in the list above, the one that describes all the press plates(' images')ofa
job, also describes on which merged plates('plates')they were exposed on.

For each <image>, its <Plate Id> text value refers to the <Plate> element, with that same value for its
attribute "id=".

1 Attention: When you move a job from one CDI device queue to the another CDI device
queue, it will get a new plate Id. Systems that interpret the "Submit to Flexo Device" XML
reports will then need to listen to that new Id ; there will be no more reporting info related to
the old ID.

An example:

Plate 1id="587e-1458-0301" requeueId="587e-1414-1501"

"1d"is the new one, "requeueId" was the original plate |d before it was moved to another
queue.

E b ] Note: This'Plate Id'is unrelated to the Plate ID objects and workflow as described in
Working with Plate ID on page 82.

« <IldOnPlate>: This is a unique identifier for the press plate. In the views Press Plates and Press Plate
Sets, you can see (and filter on)them by using the column Press Plate Id.
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